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Data Mining Overview

SAS defines data mining as the process of uncovering hidden patterns in large
amounts of data. Many industries use data mining to address business problems and
opportunities such as fraud detection, risk and affinity analyses, database marketing,
householding, customer churn, bankruptcy prediction, and portfolio analysis.The SAS
data mining process is summarized in the acronym SEMMA, which stands for
sampling, exploring, modifying, modeling, and assessing data.

o Sample the data by creating one or more data tables. The sample should be large
enough to contain the significant information, yet small enough to process.

0 Explore the data by searching for anticipated relationships, unanticipated trends,
and anomalies in order to gain understanding and ideas.

0 Modify the data by creating, selecting, and transforming the variables to focus the
model selection process.

0O Model the data by using the analytical tools to search for a combination of the
data that reliably predicts a desired outcome.
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O Assess the data by evaluating the usefulness and reliability of the findings from
the data mining process.

You might not include all of these steps in your analysis, and it might be necessary to
repeat one or more of the steps several times before you are satisfied with the results.
After you have completed the assessment phase of the SEMMA process, you apply the
scoring formula from one or more champion models to new data that might or might not
contain the target. The goal of most data mining tasks is to apply models that are
constructed using training and validation data in order to make accurate predictions
about observations of new, raw data.

The SEMMA data mining process is driven by a process flow diagram, which you can
modify and save. The GUI is designed in such a way that the business analyst who has
little statistical expertise can navigate through the data mining methodology, while the
quantitative expert can go “behind the scenes” to fine-tune the analytical process.

SAS Enterprise Miner 5.2 contains a collection of sophisticated analysis tools that
have a common user-friendly interface that you can use to create and compare multiple
models. Statistical tools include clustering, self-organizing maps / Kohonen, variable
selection, trees, linear and logistic regression, and neural networking. Data preparation
tools include outlier detection, variable transformations, data imputation, random
sampling, and the partitioning of data sets (into train, test, and validate data sets).
Advanced visualization tools enable you to quickly and easily examine large amounts of
data in multidimensional histograms and to graphically compare modeling results.

Enterprise Miner is designed for PCs or servers that are running under Windows XP,
UNIX, Linux, or subsequent releases of those operating environments. The figures and
screen captures that are presented in this document were taken on a PC that was
running under Windows XP.

Layout of the Enterprise Miner Window

About the Graphical Interface

You use the Enterprise Miner graphical interface to build a process flow diagram that
controls your data mining project.
Figure 1.1 shows the components of the Enterprise Miner window.
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Figure 1.1 The Enterprise Miner Window
Enterprize Miner - Getting Started Charitable Giving Example
File Edit “iew Actionz Optionz  Window Help
Toobar 0 ) 0o ol 2 1
Toolbar Shortcut i R REEE
Buttons Samplel Explorel Modifyl Modell Assessl Lrtil'rt\,n'l Credit Scoringl

Project Panel ——

Properties Panel—

Diagram Workspace

Help Pangl ——

Status Bar——

B Dats Sources i -
[=H 2] Diagratns .—)—Q _M‘LJ. ' ﬁ-]._—
:Ed?;:::::es StatExplore MultiPlot Impute
Al Users pre=reey
» i e
Property I Walue I DONOR_RA Decision Tree
Mode 1D MdIComp || DATA
Imported Data
Exported Data WA ‘{';h.
ariables = = bz
Narila Rin an i Data Padition Replacement Interactive
— Decision Tree
Node ID
Mode [dentifier -
y | of

IE Conhected to SASMain - Logical Workspace Server

biagram Donations opened

The Enterprise Miner window contains the following interface components:

O

Toolbar and Toolbar shortcut buttons — The Enterprise Miner Toolbar is a graphic
set of node icons that are organized by SEMMA categories. To the right side of the
toolbar is a collection of Toolbar shortcut buttons that are commonly used to build
process flow diagrams in the Diagram Workspace. Move the mouse pointer over
any node, or shortcut button to see the text name. Drag a node or tool into the
Diagram Workspace to use it. The Toolbar icon remains in place and the node in
the Diagram Workspace is ready to be connected and configured for use in your
process flow diagram. Click on a shortcut button to use it.

Project Panel — Use the Project Panel to manage and view data sources,
diagrams, model packages, and project users.

Properties Panel — Use the Properties Panel to view and edit the settings of data
sources, diagrams, nodes, model packages, and users.

Diagram Workspace — Use the Diagram Workspace to build, edit, run, and save
process flow diagrams. This is where you graphically build, order, sequence and
connect the nodes that you use to mine your data and generate reports.

Help Panel — The Help Panel displays a short description of the property that you
select in the Properties Panel. Extended help can be found in the Help Topics
selection from the Help main menu or from the Help button on many windows.

Status Bar — The Status Bar is a single pane at the bottom of the window that
indicates the execution status of a SAS Enterprise Miner task.
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Enterprise Miner Menus

Here is a summary of the Enterprise Miner menus:
o File
O New
O Project — creates a new project.
o Diagram — creates a new diagram.
0 Data Source — creates a new data source using the Data Source wizard.

Open Project — opens an existing project. You can also create a new project
from the Open Project window.

O

Recent Projects — lists the projects on which you were most recently working.

Open Model Package — opens a model package SAS Package (SPK) file that
you have previously created.

o o

o Explore Model Packages — opens the Model Package Manager window, in
which you can view and compare model packages.

Model Package Manager

—Search Maodel Packages

Repositories:  [g82.com: Foundation Function: ll‘.ll LI
| d; | >| Algorithm: ll\.ll Ll

Groups: Al 7 Name(CDntains):l
Subrmit | Reset |

~Result:

[elete | Fegister | 0=l I Cloge | Help |

o0 Open Diagram — opens the diagram that you select in the Project Panel.

0 Close Diagram — closes the open diagram that you select in the Project Panel.

0 Close this Project — closes the current project.

0 Delete this Project — deletes the current project.

0 Import Diagram from XML — imports a diagram that has been defined by an
XML file.

0 Save Diagram As — saves a diagram as an image (BMP or GIF) or as an
XML file.

o0 Print Diagram — prints the contents of the window that is open in the

Diagram Workspace.
o Exit — ends the Enterprise Miner session and closes the window.

o Edit
O Cut — deletes the selected item and copies it to the clipboard.
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Copy — copies the selected node to the clipboard.

Paste — pastes a copied object from the clipboard.

Delete — deletes the selected diagram, data source, or node.
Rename — renames the selected diagram, data source, or node.
Duplicate — creates a copy of the selected data source.

O Ooo oo d

Select All — selects all of the nodes in the open diagram, selects all texts in the
Program Editor, Log, or Output windows.

O

Clear All — clears text from the Program Editor, Log, or Output windows.

o Find/Replace — opens the Find/Replace window so that you can search for and
replace text in the Program Editor, Log, and Results windows.

0 Go To Line — opens the Go To Line window. Enter the line number on which
you want to enter or view text.

o Layout

0 Horizontally — creates an orderly horizontal arrangement of the layout of
nodes that you have placed in the Diagram Workspace.

O Vertically — creates an orderly vertical arrangement of the layout of nodes
that you have placed in the Diagram Workspace.

O Zoom — increases or decreases the size of the process flow diagram within the
diagram window.

View

o Property Sheet
0 Basic — displays the basic properties in the Properties Panel.

0 Advanced — displays the basic and advanced properties in the Properties
Panel.

o Hide — removes the Properties Panel and the Help Panel from the user
interface.

0 Program Editor — opens a SAS Program Editor window in which you can enter
SAS code.

o Log — opens a SAS Log window.

0 Output — opens a SAS Output window.

0 Graphs — opens the Graphs window. Graphs that you create with SAS code in
the Program Editor are displayed in this window.

o Table — opens a table from the libraries that you have defined. You select a
table from the Select a SAS Table window.

0 Refresh Project — updates the project tree to incorporate any changes that were
made to the project from outside the Enterprise Miner user interface.

Actions
0 Add Node — adds a node that you have selected to the Diagram Workspace.
0 Select Nodes — opens the Select Nodes window.

0 Connect nodes — opens the Connect Nodes window. You must select a node in
the Diagram Workspace to make this menu item available. You can connect the
node that you select to any nodes that have been placed in your Diagram
Workspace.

0 Update — updates the selected node to incorporate any changes that you have
made.

0 Run — runs the selected node and any predecessor nodes in the process flow

that have not been executed, or submits any code that you type in the Program
Editor window.
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Stop Run — interrupts a currently running process flow.
View Results — opens the Results window for the selected node.
Create Model Package — generates a mining model package.

Export Path as SAS Program — saves the path that you select as a SAS
program. In the window that opens, you can specify the location to which you
want to save the file. You also specify whether you want the code to run the

path or create a model package.

o Options
0 Preferences — opens the Preferences window. Use the following options to

change the user interface:

Preferences
Property Walue
=
Look and feel System
IProperty Sheet Toaltips 2N

Interactive Sampling

Display toal name and description

Model Package Options
|Generate C Score Code

[Sample Method Top
|Fetch Size Default
|Random Seed 123445

L]

|[Generate Java Score Code

L]

Wava Score Code Package
M
“|Grid Processing Mlever use grid processing

Ok Cancel |

Look and Feel — you can select cross Platform, which uses a standard
appearance scheme that is the same on all platforms, or System which uses
the appearance scheme that you have chosen for your platform.

Property Sheet Tooltips — controls whether tooltips are displayed on various
property sheets appearing throughout the user interface.

Tools Palette Tooltips — controls how much tooltip information you want
displayed for the tool icons in the tools palette.

Sample Methods — generates a sample that will be used for graphical
displays. You can specify either Top or Random.

Fetch Size — specifies the number of observations to download for graphical
displays.

Random Seed — specifies the value you want to use to randomly sample
observations from your input data.

Generate C Score Code — creates C score code when you create a report. By
default, this option is selected.

Generate Java Score Code — creates Java score code when you create a
report. By default, this option is selected. If you select Generate Java
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Score Code, then enter a filename for the score code package in the Java
Score Code Package box.

0 Java Score Code Package — identifies the filename of the Java Score Code
package.

0 Grid Processing — enables you to use grid processing when you are running
data mining flows on grid-enabled servers.

o Window

o Tile — displays windows in the Diagram Workspace so that all windows are
visible at the same time.

o Cascade — displays windows in the Diagram Workspace so that windows

overlap.
o Help

o Contents — opens the Enterprise Miner Help window, which enables you to
view all the Enterprise Miner Reference Help.

0 Component Properties — opens a table that displays the component
properties of each tool.

0 Generate Sample Data Sources — creates sample data sources that you can
access from the Data Sources folder.

0 Configuration — displays the current system configuration of your Enterprise
Miner session.

O About — displays information about the version of Enterprise Miner that you
are using.

Diagram Workspace Pop-up Menus

You can use the Diagram Workspace pop-up menus to perform many tasks. To open
the pop-up menu, right-click in an open area of the Diagram Workspace. (Note that you
can also perform many of these tasks by using the pull-down menus.) The pop-up menu
contains the following items:

O Add node — accesses the Add Node window.

O Paste — pastes a node from the clipboard to the Diagram Workspace.

O Select All — selects all nodes in the process flow diagram.

O Select Nodes — opens a window that displays all the nodes that are on your
diagram. You can select as many as you want.

O Layout Nodes — creates an orderly arrangement of the nodes in the Diagram
Workspace.

O Zoom — increases or decreases the size of the process flow diagram within the
diagram window by the amount that you choose.

Organization and Uses of Enterprise Miner Nodes

Abhout Nodes

The nodes of Enterprise Miner are organized according to the Sample, Explore,
Modify, Model, and Assess (SEMMA) data mining methodology. In addition, there are
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also Credit Scoring and Utility node tools. You use the Credit Scoring node tools to
score your data models and to create freestanding code. You use the Utility node tools
to submit SAS programming statements, and to define control points in the process flow
diagram.

All of the Enterprise Miner nodes are listed in a set of folders that are located on the
Tools tab of the Enterprise Miner Project Navigator. The nodes are listed under the
folder that corresponds to their data mining functions.

Note: The credit Scoring tab does not appear in all installed versions of
Enterprise Miner. o

Remember that in a data mining project, it can be an advantage to repeat parts of
the data mining process. For example, you might want to explore and plot the data at
several intervals throughout your project. It might be advantageous to fit models,
assess the models, and then refit the models and then assess them again.

The following tables list the nodes, give each node’s primary purpose, and supply
examples and illustrations.

Sample Nodes

Node Name Description

Input Data Source Use the Input Data Source node to access SAS data sets and other
types of data. This node introduces a predefined Enterprise Miner
Data Source and metadata into a Diagram Workspace for processing.
You can view metadata information about your data in the Input
Data Source node, such as initial values for measurement levels and
model roles of each variable. Summary statistics are displayed for
interval and class variables. See Chapter 3.

Data Partition Use the Data Partition node to partition data sets into training, test,
and validation data sets. The training data set is used for
preliminary model fitting. The validation data set is used to monitor
and tune the model weights during estimation and is also used for
model assessment. The test data set is an additional hold-out data
set that you can use for model assessment. This node uses simple
random sampling, stratified random sampling, or user defined
partitions to create partitioned data sets. See Chapter 3.
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Node Name

Description

Sample

Time Series

Use the Sample node to take random, stratified random samples,
and to take cluster samples of data sets. Sampling is recommended
for extremely large databases because it can significantly decrease
model training time. If the random sample sufficiently represents the
source data set, then data relationships that Enterprise Miner finds
in the sample can be extrapolated upon the complete source data set.
The Sample node writes the sampled observations to an output data
set and saves the seed values that are used to generate the random
numbers for the samples so that you can replicate the samples.

Use the Time Series node to convert transactional data to time series
data to perform seasonal and trend analysis. This node enables you
to understand trends and seasonal variations in the transaction data
that you collect from your customers and suppliers over the time, by
converting transactional data into time series data. Transactional
data is time-stamped data that is collected over time at no particular
frequency. By contrast, time series data is time-stamped data that is
collected over time at a specific frequency. The size of transaction
data can be very large, which makes traditional data mining tasks
difficult. By condensing the information into a time series, you can
discover trends and seasonal variations in customer and supplier
habits that might not be visible in transactional data.

Explore Nodes

Node Name

Description

Association

Cluster

Use the Association node to identify association relationships within
the data. For example, if a customer buys a loaf of bread, how likely
is the customer to also buy a gallon of milk? You use the Association
node to perform sequence discovery if a time-stamped variable (a
sequence variable) is present in the data set. Binary sequences are
constructed automatically, but you can use the Event Chain Handler
to construct longer sequences that are based on the patterns that the
algorithm discovered.

Use the Cluster node to segment your data so that you can identify
data observations that are similar in some way. When displayed in a
plot, observations that are similar tend to be in the same cluster,
and observations that are different tend to be in different clusters.
The cluster identifier for each observation can be passed to other
nodes for use as an input, ID, or target variable. This identifier can
also be passed as a group variable that enables you to automatically
construct separate models for each group.
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Node Name

Description

MultiPlot

Path Analysis

SOM/Kohonen

StatExplore

Variable Selection

Use the MultiPlot node to explore larger volumes of data graphically.
The MultiPlot node automatically creates bar charts and scatter
plots for the input and target variables without requiring you to
make several menu or window item selections. The code that is
created by this node can be used to create graphs in a batch
environment. See Chapter 3.

Use the Path Analysis node to analyze Web log data and to
determine the paths that visitors take as they navigate through a
Web site. You can also use the node to perform sequence analysis.

Use the SOM/Kohonen node to perform unsupervised learning by
using Kohonen vector quantization (VQ), Kohonen self-organizing
maps (SOMs), or batch SOMs with Nadaraya-Watson or local-linear
smoothing. Kohonen VQ is a clustering method, whereas SOMs are
primarily dimension-reduction methods.

Use the StatExplore node to examine variable distributions and
statistics in your data sets. You can use the StatExplore node to
compute standard univariate distribution statistics, to compute
standard bivariate statistics by class target and class segment, and to
compute correlation statistics for interval variables by interval input
and target. You can also combine the StatExplore node with other
Enterprise Miner tools to perform data mining tasks such as using
the StatExplore node with the Metadata node to reject variables,
using the StatExplore node with the Transform Variables node to
suggest transformations, or even using the StatExplore node with
the Regression node to create interactions terms. See Chapter 3.

Use the Variable Selection node to evaluate the importance of input
variables in predicting or classifying the target variable. To preselect
the important inputs, the Variable Selection node uses either an
R-Square or a Chi-Square selection (tree-based) criterion. You can
use the R-Square criterion to remove variables in hierarchies,
remove variables that have large percentages of missing values, and
remove class variables that are based on the number of unique
values. The variables that are not related to the target are set to a
status of rejected. Although rejected variables are passed to
subsequent nodes in the process flow diagram, these variables are
not used as model inputs by a more detailed modeling node, such as
the Neural Network and Decision Tree nodes. You can reassign the
status of the input model variables to rejected in the Variable
Selection node. See Chapter 5.
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Modify Nodes

Node Name

Description

Drop

Filter

Impute

Principal Components

Use the Drop node to drop certain variables from your scored
Enterprise Miner data sets. You can drop variables that have roles
of Assess, Classification, Frequency, Hidden, Input, Rejected,
Residual, and Target from your scored data sets.

Use the Filter node to apply a filter to the training data set in order
to exclude outliers or other observations that you do not want to
include in your data mining analysis. The Filter node does not filter
observations in the validation, test, or score data sets. Checking for
outliers is recommended as outliers can greatly affect modeling
results and, subsequently, the classification and prediction precision
of fitted models.

Use the Impute node to impute (fill in) values for observations that
have missing values. You can replace missing values for interval
variables with the mean, median, midrange, mid-minimum spacing,
distribution-based replacement. Alternatively, you can use a
replacement M-estimator such as Tukey’s biweight, Hubers, or
Andrew’s Wave. You can also estimate the replacement values for
each interval input by using a tree-based imputation method.
Missing values for class variables can be replaced with the most
frequently occurring value, distribution-based replacement,
tree-based imputation, or a constant. See Chapter 5.

Use the Principal Components node to perform a principal
components analysis for data interpretation and dimension
reduction. The node generates principal components that are
uncorrelated linear combinations of the original input variables and
that depend on the covariance matrix or correlation matrix of the
input variables. In data mining, principal components are usually
used as the new set of input variables for subsequent analysis by
modeling nodes.
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Node Name

Description

Replacement

Transform Variables

Use the Replacement node to impute (fill in) values for observations
that have missing values and to replace specified non-missing values
for class variables in data sets. You can replace missing values for
interval variables with the mean, median, midrange, or
mid-minimum spacing, or with a distribution-based replacement.
Alternatively, you can use a replacement M-estimator such as
Tukey’s biweight, Huber’s, or Andrew’s Wave. You can also estimate
the replacement values for each interval input by using a tree-based
imputation method. Missing values for class variables can be
replaced with the most frequently occurring value,
distribution-based replacement, tree-based imputation, or a
constant. See Chapters 3, 4, and 5.

Use the Transform Variables node to create new variables that are
transformations of existing variables in your data. Transformations
are useful when you want to improve the fit of a model to the data.
For example, transformations can be used to stabilize variances,
remove nonlinearity, improve additivity, and correct nonnormality in
variables. In Enterprise Miner, the Transform Variables node also
enables you to transform class variables and to create interaction
variables. See Chapter 5.

Model Nodes

Node Name

Description

AutoNeural

Decision Tree

Dmine Regression

DMNeural

Use the AutoNeural node to automatically configure a neural
network. It conducts limited searches for a better network
configuration. See Chapters 5 and 6.

Use the Decision Tree node to fit decision tree models to your data.
The implementation includes features that are found in a variety of
popular decision tree algorithms such as CHAID, CART, and C4.5.
The node supports both automatic and interactive training. When
you run the Decision Tree node in automatic mode, it automatically
ranks the input variables, based on the strength of their
contribution to the tree. This ranking can be used to select variables
for use in subsequent modeling. You can override any automatic step
with the option to define a splitting rule and prune explicit tools or
subtrees. Interactive training enables you to explore and evaluate a
large set of trees as you develop them. See Chapters 4 and 6.

Use the Dmine Regression node to compute a forward stepwise
least-squares regression model. In each step, an independent
variable is selected that contributes maximally to the model
R-square value.

Use DMNeural node to fit an additive nonlinear model. The additive
nonlinear model uses bucketed principal components as inputs to
predict a binary or an interval target variable.
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Node Name

Description

Ensemble

MBR (Memory-Based
Reasoning)

Neural Network

Regression

Rule Induction

TwoStage

Use the Ensemble node to create new models by combining the
posterior probabilities (for class targets) or the predicted values (for
interval targets) from multiple predecessor models.

Use the MBR (Memory-Based Reasoning) node to identify similar
cases and to apply information that is obtained from these cases to a
new record. The MBR node uses k-nearest neighbor algorithms to
categorize or predict observations.

Use the Neural Network node to construct, train, and validate
multilayer feedforward neural networks. By default, the Neural
Network node automatically constructs a multilayer feedforward
network that has one hidden layer consisting of three neurons. In
general, each input is fully connected to the first hidden layer, each
hidden layer is fully connected to the next hidden layer, and the last
hidden layer is fully connected to the output. The Neural Network
node supports many variations of this general form. See Chapters 5
and 6.

Use the Regression node to fit both linear and logistic regression
models to your data. You can use continuous, ordinal, and binary
target variables. You can use both continuous and discrete variables
as inputs. The node supports the stepwise, forward, and backward
selection methods. A point-and-click term editor enables you to
customize your model by specifying interaction terms and the
ordering of the model terms. See Chapters 5 and 6.

Use the Rule Induction node to improve the classification of rare
events in your modeling data. The Rule Induction node creates a
Rule Induction model that uses split techniques to remove the
largest pure split node from the data. Rule Induction also creates
binary models for each level of a target variable and ranks the levels
from the most rare event to the most common. After all levels of the
target variable are modeled, the score code is combined into a SAS
DATA step.

Use the TwoStage node to compute a two-stage model for predicting
a class and an interval target variables at the same time. The
interval target variable is usually a value that is associated with a
level of the class target.

Note: These modeling nodes use a directory table facility, called the Model Manager,

in which you can store and access models on demand. The modeling nodes also enable

you to modify the target profile or profiles for a target variable.
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Assess Nodes

Node Name

Description

Decisions

Model Comparison

Segment Profile

Score

Use the Decisions node to define target profiles for a target that
produces optimal decisions. The decisions are made using a
user-specified decision matrix and output from a subsequent
modeling procedure.

Use the Model Comparison node to use a common framework for
comparing models and predictions from any of the modeling tools
(such as Regression, Decision Tree, and Neural Network tools). The
comparison is based on the expected and actual profits or losses that
would result from implementing the model. The node produces the
following charts that help to describe the usefulness of the model:
lift, profit, return on investment, receiver operating curves,
diagnostic charts, and threshold-based charts. See Chapter 6.

Use the Segment Profile node to assess and explore segmented data
sets. Segmented data is created from data BY-values, clustering, or
applied business rules. The Segment Profile node facilitates data
exploration to identify factors that differentiate individual segments
from the population, and to compare the distribution of key factors
between individual segments and the population. The Segment
Profile node outputs a Profile plot of variable distributions across
segments and population, a Segment Size pie chart, a Variable
Worth plot that ranks factor importance within each segment, and
summary statistics for the segmentation results. The Segment
Profile node does not generate score code or modify metadata.

Use the Score node to manage, edit, export, and execute scoring code
that is generated from a trained model. Scoring is the generation of
predicted values for a data set that might not contain a target
variable. The Score node generates and manages scoring formulas in
the form of a single SAS DATA step, which can be used in most SAS
environments even without the presence of Enterprise Miner. See
Chapter 6.
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Utility Nodes

Node Name

Description

Control Point

Merge

Metadata

SAS Code

Use the Control Point node to establish a control point to reduce the
number of connections that are made in process flow diagrams. For
example, suppose three Input Data nodes are to be connected to
three modeling nodes. If no Control Point node is used, then nine
connections are required to connect all of the Input Data nodes to all
of the modeling nodes. However, if a Control Point node is used, only
six connections are required.

Use the Merge node to merge observations from two or more data
sets or more into a single observation in a new data set. The Merge
node supports both one-to-one and match merging. In addition, you
can choose not to overwrite certain variables (such predicted values
and posterior probabilities), depending on the settings of the node.

Use the Metadata node to modify the columns metadata information
at some point in your process flow diagram. You can modify
attributes such as roles, measurement levels, and order.

Use the SAS Code node to incorporate new or existing SAS code into
process flows that you develop using Enterprise Miner. The SAS
Code node extends the functionality of Enterprise Miner by making
other SAS procedures available in your data mining analysis. You
can also write a SAS DATA step to create customized scoring code, to
conditionally process data, and to concatenate or to merge existing
data sets. See Chapter 6.

Usage Rules for Nodes

Here are some general rules that govern the placement of nodes in a process flow

diagram:

0 The Input Data Source node cannot be preceded by any other nodes.

0 All nodes except the Input Data Source and SAS Code nodes must be preceded by
a node that exports a data set.

0 The SAS Code node can be defined in any stage of the process flow diagram. It

does not require an input data set that is defined in the Input Data Source node.

0 The Assessment node must be preceded by one or more modeling nodes.

0 The Score node must be preceded by a node that produces score code. For
example, the modeling nodes produce score code.

0 The Ensemble node must be preceded by a modeling node.

0 The Replacement node must follow a node that exports a data set, such as a Data
Source, Sample, or Data Partition node.



16 Overview of the SAS Enterprise Miner 5.2 Getting Started Example A Chapter 1

Overview of the SAS Enterprise Miner 5.2 Getting Started Example

This book uses an extended example that is intended to familiarize you with the
many features of Enterprise Miner. Several key components of the Enterprise Miner
process flow diagram are covered.

In this step-by-step example you learn to do basic tasks in Enterprise Miner: you
create a project and build a process flow diagram. In your diagram you perform tasks
such as accessing data, preparing the data, building multiple predictive models,
comparing the models, selecting the best model, and applying the chosen model to new
data (known as scoring data). You also perform tasks such as filtering data, exploring
data, and transforming variables. The example is designed to be used in conjunction
with Enterprise Miner software. For details see “Configure SAS Enterprise Miner 5.2
for the Example” on page 17.

Example Problem Description

A national charitable organization seeks to better target its solicitations for
donations. By only soliciting the most likely donors, less money will be spent on
solicitation efforts and more money will be available for charitable concerns.
Solicitations involve sending a small gift to an individual along with a request for a
donation. Gifts include mailing labels and greeting cards.

The organization has more than 3.5 million individuals in its mailing database.
These individuals have been classified by their response to previous solicitation efforts.
Of particular interest is the class of individuals who are identified as lapsing donors.
These individuals have made their most recent donation between 12 and 24 months
ago. The organization has found that by predicting the response of this group, they can
use the model to rank all 3.5 million individuals in their database. The campaign refers
to a greeting card mailing sent in June of 1997. It is identified in the raw data as the
97NK campaign.

When the most appropriate model for maximizing solicitation profit by screening the
most likely donors is determined, the scoring code will be used to create a new score
data set that is named DONOR.ScoreData. Scoring new data that does not contain the
target is the end result of most data mining applications.

When you are finished with this example, your process flow diagram will resemble
the one shown below.

Q—D-Q_K‘Le

Model Y g = I
Comparisan I ? -

Score  BestPotential
Donors

| DONOR_
e Ey :*Z'Etv.' %” SCORE_DATA
Diata Partition Replacement Interactive Meural Metwork
Decision Tree

Here is a preview of topics and tasks in this example:
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Chapter Task

2 Create your project, define the data source, configure the metadata, define
prior probabilities and profit matrix, and create an empty process flow
diagram.

3 Define the input data, explore your data by generating descriptive

statistics and creating exploratory plots. You will also partition the raw
data and replace missing data.

4 Create a decision tree and interactive decision tree models.

5 Impute missing values and create variable transformations. You will also
develop regression, neural, and auto neural models. Finally, you will use
the preliminary variable selection node.

6 Assess and compare the models. Also, you will score new data using the
models.
7 Create model results packages, register your models, save and import the

process flow diagram in XML.

Note: The complete process flow diagram is provided in XML format at http://
support.sas.com/documentation/onlinedoc/miner under the Tutorials and
Samples heading. In order to use the provided XML, you must do the following:

o Complete all the instructions in “Create a New Project” on page 21.
0 Complete all the instructions in “Define the Donor Data Source” on page 23.

o Complete all the instructions in importing XML diagrams in “Save and Import
Diagrams in XML” on page 132.

This example provides an introduction to using Enterprise Miner in order to
familiarize you with the interface and the capabilities of the software. The example is
not meant to provide a comprehensive analysis of the sample data. A

Example Data Description

See Appendix 2, “Example Data Description,” on page 137 for a list of variables that
are used in this example.

Configure SAS Enterprise Miner 5.2 for the Example

Software Requirements

In order to re-create this example, you must have access to SAS Enterprise Miner 5.2
software, either as client/server application, or as a complete client on your local
machine. In order to complete all the portions of the example, you also must have the
Enterprise Miner Tree Desktop Application installed.
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Locate and Install the Example Data

Download the donor_raw_data.sas7bdat and donor_score_data.sas7bdat data
sets from http://support.sas.com/documentation/onlinedoc/miner under the
Tutorials and Samples heading.

See “Configure Example Data on a Metadata Server” on page 18 for details about
how to define and set up your data sets.

Configure Example Data on a Metadata Server

This example is designed to be performed on a two-tier Enterprise Miner 5.2 client/
server installation, the most common customer configuration. Ask your system
administrator to create a library in your Enterprise Miner server environment to
contain the example data. You and other example users will also need access to the
example data library.

Configure Your Data on an Enterprise Miner Complete Client

If you access Enterprise Miner 5.2 as a complete client, define the donor sample data
source in your local machine.

When you create a library, you give SAS a shortcut name or pointer to a storage
location in your operating environment where you store SAS files.

To create a new SAS library for your sample donor data using SAS 9.1.3, complete
the following steps:

1 From the Explorer window, select the Libraries folder.

%, SAS =] E3
File Edt View Tools Soltions ‘Window Help
[~ Hlahed] s e olxssh@eale
Explorer [=]
Cant 'SAS Environment! NOTE: Copyright (c) 2002-2003 by SAS Institute Inc., Cary, NC, USA. |
NOTE: SAS (r) 9.1 (TS1M3)
Licensed to SAS INSTITUTE, Site 0000001001,

NOTE: This session is executing on the XP_PRO platform.

m% File Shartcuts

'TI NOTE: SAS 9.1.3 Service Pack 3
59
NDTE: SAS initialization used:

Favorits My Computer real time 1.01 seconds
Folders iz D15005 cpu time 0.73 seconds

Editor - Untitled1

=
al 2 ~
[ Fesuls .1 Explorer [| B ouput- wnite | 1 Log- wriited) [ Editor- Unkiled |
/= C:\Documents and Settingslore | i

2 Select File » New .

3 In the Name box of the New Library window, enter a library reference. The library
name is Donor in this example.
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Note: Library names are limited to eight characters. A

i’ Mew Library
Lib[clly
Mame: IDonoﬂ Engine: IDefauIt j [~ Enable at startup

Library Infarmation

Bath: | Browse. .. |

Optiong: |

u] Cancel Help

4 Select an engine type. The engine type determines what fields are available in the
Library Information area. If you are not sure which engine to choose, use the
Default engine (which is selected automatically). The Default engine enables SAS
to choose which engine to use for any data sets that exist in your new library. If no
data sets exist in your new library, then the Base SAS engine is assigned.

5 Select the Enable at startup check box in the New Library window.

6 Type the appropriate information in the fields of the Library Information area.
The fields that are available in this area depend on the engine that you select.

7 For this example, click [Browse].

8 In the Select window, navigate to the folder where you downloaded the sample
data sets donor_raw_data.sas7bdat and donor_score_data.sas7bdat.

Select k HE

Loak in: I_} DonorData j & &% Ea-

donor_raw_data.sas?bdatj

§ onor_score_data.sasvbdat

Folder: IE:\EMEZ\Data\DonorData oK.

Files of type: IAII Files [*.7] j Cancel

9 Click [OK]. This selected path will appear in the Path box of the New Library
window.
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& Mew Library E

Library

Hame:  [Danar Engire: IDefauIt j ¥ Enable at startup

Library Information

Path: |E:\EM52\Data\D0nolData Browse... |

Optiohs: |

Ok Cancel Help

10 Enter any options that you want to specify. For this example, leave the options

box blank.

11 Click [OK]. The new library will appear under Libraries in the Explorer window.

File Edit “iew Toolz Soltion: ‘Window Help
1 dlalned|s e 2|58

E xplorer H

Active Libraries HOTE: Copyright (c) 2002-2003 by SAS Institu|
. NOTE: SAS (r) 9.1 (TS1M3)

Licensed to SAS INSTITUTE, Site 000000
MHOTE: This session is executing on the XP_PR

Sashelp
NOTE: SAS 9.1.3 Service Pack 3
MOTE: 5A5 initialization used:
Sasuser Wark real time 0.90 seconds
cpu time 0.74 seconds

AN

B Resuls [, Explorer | Dutput - (Untitled) | =] Log - (Untiled) | [# Editer - Untitectt |
= C:A\Documnents and Se 4
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Create a New Project

In Enterprise Miner, you store your work in projects. A project can contain multiple
process flow diagrams and information that pertains to them. It is a good idea to create
a separate project for each major data mining problem that you want to investigate.
This task creates a new project that you will use for this example.

1 To create a new project, click New Project in the Welcome to Enterprise Miner

window.

Enterprize Miner =] 3

File Edit “iew Actions Options “indow Hel

Create a Mew Enterprise Miner Project

SAS elp Topics
Enterprise e

Miner
5.2

S Mew Project

&7 Open Project...

&7 Recent Projects...

built by m

I I IV{ Mo project open
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2 The Create New Project window opens. In the Name box, type a name for the

project, such as Getting Started Charitable Giving Example.

Create Mew Project E3

General | start-up Cocte | Ext code |

Mame: IGeﬂing Started Charitable Giving Example

Haost: ISASMain - Logical Woarkspace Server LI

Path: IC:DocumEMS ahd Settings\sasuzerihly DocumentsWy SA5 Files'3 1'EM_Projects

Ok I Cancel | Help |

3 In the Host box, connect to the main SAS application (or workspace) server,

named SASMain by default. Contact your system administrator if you are unsure
of your site’s configuration.

In the Path box, type the path to the location on the server where you want to
store the data that is associated with the example project. Your project path
depends on whether you are running Enterprise Miner as a complete client on
your local machine or as a client/server application.

If you are running Enterprise Miner as a complete client, your local machine
acts as its own server. Your Enterprise Miner projects are stored on your local
machine, in a location that you specify, such as ¢: \EMProjects.

If you are running Enterprise Miner as a client/server application, all projects
are stored on the Enterprise Miner server. Ask your system administrator to
configure the library location and access permission to the data source for this
example.

If you see a default path in the Path box, you can accept the default project path,
or you can specify your own project path. This example uses C: \EM52\Projects\.

On the start-Up Code tab, you can enter SAS code that you want SAS Enterprise
Miner to run each time you open the project. Enter the following statement.

options nofmterr;
libname donor ‘‘<path-to-your-example-library>’"';

Note: You should replace <path-to-your-example-library> with the path
specification that points to your example data files, either on an Enterprise Miner
server, or on your complete client’s local machine. The example example uses the
local path specification, ¢: \EM52\Data\DonorData. In SAS code, remember to
enclose your path specification in double quotation marks. A
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Create Mew Project E3

General Stert-Up Code | Exit Code |

options nofmterr;
libnawe donor "CrA\EMSZ\Data\DenorData™:

| »

=l
Ok I Cancel | Help |

Similarly, you can use the Exit Code tab to enter SAS code that you want
Enterprise Miner to run each time you exit the project. This example does not use
the SAS exit code.

6 Click [OK]. The new project will be created and it opens automatically.

Note: Example results might differ from your results. Enterprise Miner nodes and
their statistical methods might incrementally change between releases. Your process
flow diagram results might differ slightly from the results that are shown in this
example. However, the overall scope of the analysis will be the same. A

Define the Donor Data Source

Overview of the Enterprise Miner Data Source

In order to access the example data in Enterprise Miner, you need to define the
imported data as an Enterprise Miner data source. An Enterprise Miner data source
stores all of the data set’s metadata. Enterprise Miner metadata includes the data set’s
name, location, library path, as well as variable role assignments measurement levels,
and other attributes that guide the data mining process. The metadata is necessary in
order to start data mining. Note that Enterprise Miner data sources are not the actual
training data, but are the metadata that defines the data source for Enterprise Miner.

The data source must reside in an allocated library. You assigned the libname Donor
to the data that is found in ¢:\EM52\Data\DonorData when you created the start-up
code for this example.

The following tasks use the Data Source wizard in order to define the data source
that you will use for this example.

Specify the Data Type

In this task you open the Data Source wizard and identify the type of data that you
will use.
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1 Right-click the Data Sources folder in the Project Navigator and select create
Data Source to open the Data Source wizard. Alternatively, you can select File »
New » Data Source from the main menu, or you can click the
[Create Data Source| on the Shortcut Toolbar.

Enterprize Miner - Gettling Started Charitable Giving
File Edit Wiew Actions Options “Window Help

EERE K
| Samglel Explcnrel Madifvl Mudell Assesslm Al E

Getting Started Chatitable Giving Example
il |Data Sources,
| Disgrams

= | Moddel Packages
A Users

E Create Data Source

2 In the source box of the Data Source Wizard Metadata Source window, select SAS
Table to tell SAS Enterprise Miner that the data is formatted as a SAS table.

M= E3

Data Source Wizard -- Step 1 of 6 Metadata Source

Select a metadata source

Source :

Cancel | Help |

= Bk | Mext =

3 Click [Next]. The Data Source Wizard Select a SAS Table window opens.

Select a SAS Tahle
In this task, you specify the data set that you will use, and view the table metadata.

1 Click in the Data Source Wizard — Select a SAS Table window. The Select
a SAS Table window opens.
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Data Source Wizard -- Step 2 of 6 Select a 5A5 Table (- [O]X]

Select a SAS tahle

Table :

= Back | Mext = Cancel | Help |

2 Double-click the SAS library named DONOR. It is the library that you or your
system administrator assigned in the start-up code. The DONOR library folder
expands to show all the data sets that are in the library.

3 Select the DONOR_RAW_DATA table and click [OK]. The two-level name
DONOR.DONOR_RAW_DATA appears in the Table box of the Select a SAS Table
window.

Select a SAS Table

DONOR
Eloonor_Rew DaTa
B
F= DONOR_SCORE DATA
SAMPSIO
SASHELP

Refresh Propetties. .. Ok Cancel
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4 Click [Next]. The Table Information window opens. Examine the metadata in the

Table Properties section. Notice that the DONOR_RAW_DATA data set has 50
variables and 19,372 observations.

Data Source Wizard -- S5tep 3 of 6 Table Information (- [O]X]

Tahle Properties

.. Property Walle I
A Table Matrne DOMOR . DOMOR_RAW_DATS
Drezcription
. hember Type DATA
‘. Data et Type DATA
. Engine e
. Mumber of Yariahles Al
2 Murmber of Observations 19372
M Created Date 2001-09-2011:00: 40,575
L] Modified Date 2001 -09-20011:00: 40,975
L]
L]
.
L]

= Back

Cancel | Help |

5 After you finish examining the table metadata, click [Next]. The Data Source
Wizard Metadata Advisor Options window opens.

Configure the Metadata

The Metadata Configuration step activates the Metadata Advisor, which you can use

to control how Enterprise Miner organizes metadata for the variables in your data
source.

In this task, you generate and examine metadata about the variables in your data set.
1 Select Advanced and click [Customize].

Data Source Wizard -- Step 4 of 6 Metadata Advisor Options !E[

Metadata Advisor Options

Lse the hasic setting to setthe initial measurement levels and roles
hased on the variable attributes.

Use the advanced setting to setthe initial measurement levels and
roles hased on hoth the variable attributes and distributions.

' Basic *

Customize... |

= Back | Mext =

Cancel | Help |

The Advanced Advisor Options window opens.
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In the Advanced Advisor Options window, you can view or set additional
metadata properties. When you select a property, the property description appears
in the bottom half of the window.

Property I “alue I
Mizsing Percentage Threshald an
Reject Yars with Excessive Missing Valueyes
Class Levels Count Threshold 20
Detect Class Levels es
Reject Levels Count Threshaold 20
Feject ¥ars with Excessive Class Walues Yes
=v
Missing Percentage Threshold

Specify a masmum percentage of missing walues for variables to be rejected.
The default walue is 50,

(0.4 I Cancel Help

Notice that the threshold value for class variables is 20 levels. You will see the
effects of this setting when you view the Column Metadata window in the next
step. Click to use the defaults for this example.

2 Click in the Data Source Wizard Metadata Advisor Options window to
generate the metadata for the table. The Data Source Wizard Column Metadata
window opens.

Note: In the Column Metadata window, you can view and, if necessary, adjust the
metadata that has been defined for the variables in your SAS table. Scroll through
the table and examine the metadata. In this window, columns that have a white

background are editable, and columns that have a gray background are not
editable. A
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3 Select the Names column header to sort the variables alphabetically.

Data Source Wizard -- 5tep 5 of 6 Column Metadata M=
Showy code | Explore |
[ hame £ | Role | Level Reg
a CARD_PROM_12 Input Mominal Mo =]
E CLUSTER_CODE Rejected Nominal Mo
: CONTROL_MUMBER Rejected Nominal Mo
. DONOR_AGE nput Intenval No
DONOR_GEMDER nput Nominal Mo
FILE_AWG_GIFT nput nterval Mo
FILE_CARD_GIFT nput nterval Mo
FEEQLEMCY STATUS 97MIK nput Nominal Mo
. HOME_OWHER nput Binary Mo
- INCOME_GROUP nput Nominal Mo
™ IN_HOUSE Input Binary Mo
L] LAST GIFT_AMT nput hterval Mo
- LIFETIME_AYG_GIFT_AMT nput hterval Mo
* LIFETIME_CARD_FROM nput nterval Mo
LIFETIME_GIFT_AMOUNT nput nterval Mo
LIFETIME_GIFT_COUNT nput nterval Mo -
HEETIME _SIFT COUNT = terval ! _>I_I
= Back | Mext = Cancel | Help |

Note that the roles for the variables CLUSTER_CODE and
CONTROL_NUMBER are set to Rejected because the variables exceed the
maximum class count threshold of 20. This is a direct result of the threshold
values that were set in the Data Source Wizard Metadata Advisory Options
window in the previous step. To see all of the levels of data, select the columns of
interest and then click in the upper right-hand corner of the window.

4 Redefine these variable roles and measurement levels:

o Set the role for the CONTROL_NUMBER variable to ID.

O Set these variables to the Interval measurement level:

o CARD_PROM_12

INCOME_GROUP
RECENT_CARD_RESPONSE_COUNT
RECENT_RESPONSE_COUNT
WEALTH_RATING

O

o o o
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5 Set the role for the variable TARGET _D to Rejected, since you will not model this
variable. Note that Enterprise Miner correctly identified TARGET_D and
TARGET_B as targets since they start with the prefix TARGET.

Data Source ‘Wizard -- Step 5 of 6 Column Metadata

I[=] E3

Shavy code | Explore |

Matre

a
=
m

I Lewvel

Re|

FEF_STAR nput Einary Mo d
PER_CAPITA_INCOME Fﬂt Intenral No
PUBLISHED_PHOMNE nput Binary No
RECENCY_STATUS_36MK nput Nominal No
RECENT_AWG CARD_GIFT_AMT nput No
RECENT_AWG_GIFT_AMT nput No
RECENT _CARD _RESPOMSE COUNT Input No
RECENT_CARD _RESPOMSE_PROF  Input No
RECENT _RESPONSE_COUNT nput No
RECENT_RESFONSE_FROP nput No
RECENT_STAR_STATUS Fﬂt No
SES nput
TARGET B et
TARGET_D
URBANICITY

EALTH_RATING

6 Select the TARGET_B variable and click to view the distribution of
TARGET_B. As an exercise, select additional variables and explore their

distributions.

Data Source ‘Wizard -- Step 5 of 6 Column Metadata H=] E3
Shavy code | Explore
I Marme | Role I Level RE|V
[} o —
x FEF_STAR nput Einary Mo d
[}
2 PER_CAPITA_IMCOME Ennut lntenral Mo
b PLBELISHED_PHOMNE nput Binary Mo
- RECEMCY _STATUS_96MK nput Nominal Mo
RECEMT AWG_CARD GIFT_AMT nput Mo
RECEMT_AVG_GIFT_AMT nput Mo
RECEMT_CARD_RESPOMSE_COUNT Input Mo
RECEMT_CARD_RESPOMSE_PROP  Input No
. RECEMT_RESPOMSE_COUNT nput Mo
. RECEMT_RESPOMNSE_PROP nput Mo
o RECEMT_STAR_STATUS nput Mo
.’ SES Enput Mominal Mo
- TARGET_B Target Binary Ho
TARGET D Rejected  Interval Mo
LIRBAMICITY nput Numinal Ho
EALTH_RATIMNG nput Intenral Mo -~
‘ 0
= Back | et = Cancel | Help |
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Explore - DONOR
Fle Edt View Actions “Window

S|E|O 4
§: 5ampla Proparties IRI=E]| . TARGET_B 1 1 3
5,000

ATAR [_[o[x]

Library DONOR
“Member DONOR_RAW_DATA
Type DATA 6,000
-Rows 19372
Columns 50 g
Sample Method }ﬁn H
Fetch Size [Default 24,000
Random Seed 12345 [
— fro

2,000+

0 1
Apply o Target Variable Indicates for Response to 97NK M

obs# | Targst Vari

E

cclo-lo-ooooo-=o

7 In the Sample Properties window, set Fetch Size to Max and then click

- - Explore - DONOR.DONOR_RAW_DATA M=l B3
File Wiew Actions ‘wWindow

8,000

Random Seed
[Fetehed Rows

Frequency

0 1
ﬂl (R Target Variable Indicates for Response to 97...

Ohs # Target Vari

i [ i’
2 1
3 i}
4 i
5 a
6 o
T o
g8 1
1 i
10 1
11 i
12 i
13 i
14 i}
15 1
] ]




Setting Up Your Project /A Configure the Metadata

8 Select the bar that corresponds to donors (TARGET_B =1’) on the TARGET_B
histogram and note that the donors are highlighted in the
DONOR.DONOR_RAW_DATA table.

- ~Explore - DONOR.DOMOR_RAW_DATA M=l B3
File ‘“iew Actions ‘window

B0\ 4]
4§ : Sample Properties =10l TARGET_B =l01x]
15000

Sample Method op
Fetch Size Pax
Random Seed 12345 10000 -
Fetched Rows [1aaz2 g
s
=
2
=~ so00
i y
| A
0

|
1

Apply | Flat... | Target Variable Indicates for Respo...

ONOR.DONOR_BAW_DATA 1 [=1

Chs # I Target Vari...l
4

(== == R R = L N S
= o= oo0o0oo=o0

9 Close the Explore window.

10 Sort the Metadata table by Level and check your customized metadata
assignments.

Showy code | Explore |
Ilame | Role Level / | Regp
oo e—
MONTHS_SINCE_FIRST _GIFT nput ntensal Mo il
MOR_HIT_RATE nput ntensal Mo
MOMNTHS _SINCE_LAST PROM_RESP Input nterval Mo
LIFETIME_AWG_GIFT _AMT nput nterval Mo
LIFETIME_CARD_PROM nput nterval Mo
CARD_PROM_12 Input nterdal Mo
DONOR_AGE nput nterval Mo
LIFETIME_GIFT_COUNT nput nterval Mo
CONTROL_MUMBER D Nominal Mo
OVERLAY _SOURCE nput Numinal Mo
DOMOR_GEMDER nput Numinal Mo
CLUSTER_CODE jected Numinal Mo
FREQUEMCY STATUS _87MNK nput Numinal Mo
UREBAMICITY nput Nominal Mo
RECEMCY STATUS 96MIK nput Nominal Mo
SES nput Hominal Mo -
K 2
= Back | Mext = Cancel | Help |
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11 Select the Report column and select Yes for URBANICITY and DONOR_AGE to
define them as report variables. These variables will be used as additional
profiling variables in results such as assessment tables and cluster profiles plots.

Data Source Wizard -- 5tep 5 of 6 Column Metadata M=
Showy code | Explore |
n Iame |,...-I'£\£LI Repaort | C
: MONTHS_SINCE_FIRST _GIFT nterval No il
: MOR_HIT_RATE nterval Ho
- MOMNTHS _SINCE_LAST PEOM_RESFE Interval MNo
- LIFETIME_AWG_GIFT _AMT nterval Mo
LIFETIME_CARD_PROM nterval No
CARD_PROM_12 Interval No
DOMNOR_AGE nterval Yes |
LIFETIME_GIFT_COUNT nterval No
. CONTROL_MUMBER Morinal hlu
. OVERLAY_SOURCE Morinal blu
* DONOR_GEMDER Morinal blu
.. CLUSTER_CODE Morinal hu
. FREQUEMCY STATUS _87MNK Morinal No
LRBAMNICITY Hominal Yes
RECEMCY STATUS 96MIK Mominal MNo
SES Mominal Mo A
. 2
= Back | Mext = Cancel | Help |

12 Click to open the Data Source Wizard Decision Configuration window.

Data Source Wizard -- Step 6 of 8 Decision Eonliguratior—k

Decision Processing

Do you wyant to build models based on the values of the decisions 7

If you answer yes, you may erter infarmation on the cost or profit of esch
possible decizion, prior probahbilty and cost function. The data will be scanned
far the distributions of the target variables.

Mo

= Back | Mext = Cancel | Help |

To end this task, select Yes and click in order to open the Decision
Configuration window.

Define Prior Probabilities and a Profit Matrix

The Data Source Wizard Decision Configuration window enables you to define a
target profile that produces optimal decisions from a model. You can specify target
profile information such as the profit or loss of each possible decision, prior
probabilities, and cost functions. In order to create a target profile in the Decision
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Configuration window, you must have a variable that has a role of Target in your data
source. You cannot define decisions for an interval level target variable.

In this task, you specify whether to implement decision processing when you build
your models.

Data Source Wizard -- Step 7 of 8 Decision Configuration

Targets | Priar Probabilitiesl Qecisionsl Decision \ﬂeightsl

Name : TARGET B
Measurement Level : Binaty
Target level order :  Descending
Event level : 1

Format :

= Back

Cancel | Help |

1 Select the Prior Probabilities tab. Click to reveal the Adjusted Prior
column and enter the following adjusted probabilities, which are representative of
the underlying population of donors.

o Level 1 =0.05
o Level 0 = 0.95

Data Source Wizard -- Step 7 of 8 Decision Configuration

Targets Prior Probabiities | Qecisionsl Decigion \ﬂeightsl
[o you wvant to enter new prior probabilties?
& es Mo
Lewel I Court I Priar I Adjusted Prior I
1 .. 4543 lnzs lnos |
o .. 14529 lo7s loas |
o
L
= Back | Mext = Cancel | Help |

2 Select the Decision Weights tab and specify the following weight values:
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Level Decision 1 Decision 2
1 14.5 0
0 -0.5 0

A profit value of $14.50 is obtained after accounting for a 50—cent mailing cost
The focus of this example will be to develop models that maximize profit.

Data Source Wizard -- Step 7 of 8 Decision Configuration

Targets I Prior Probahilities | Decisions

Select a decizion function:

& Maximize

 Minirmize

Erter wweight values for the decizions.

Level | DECisiom | DEcmionz |
1 145 [ |
o 05 o |

= Back | Mext =

Cancel | Help |

3 Click to open the Data Source Attributes window. In this window, you can
specify a name, role, and segment for your data source.

Data Source Wizard -- Step 8 of 8§ Data Source Attributes

Ty U

b

M= E3

You may change the name and the role, and can specify a population
segment identifier for the data source to be created.

Name:  [DONOR_RAW_DATA

Role: |Raw LI
Segment: |
Motes

= Back Cancel | Help |

Navigator.

4 Click to add the donor table to the Data Sources folder of the Project
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Note: You can also define global data sources that can be used across multiple
projects. A

Optional Steps

0 The data source can be used in other diagrams. Expand the Data Sources folder.
Select the DONOR_RAW_DATA data source and notice that the Property panel
now shows properties for this data source.

Enterprise Miner - Getting Started Charitable Giving Example

File Edit View Action: Options ‘Window Help

Ol & fef |
‘M Explorel Modifyl Modell Azzess |M| Credit Scoringl

Getting Started Charitable Giving Example
EHER Data Sources

] ponoR_Raw_DaTa

x| Diagrams

= | Model Packages

Al Users

Create a Diagram

Now that you have created a project and defined your data source, you are ready to

begin building your process flow diagram. This task creates a new process flow diagram
in your project.

1 Right-click the Diagrams folder of the Project Navigator and select create
Diagram.

Getting Started Charitable Giving Example
EHED Data Sources
DOMNOR_R&W DATA

| hodel Pa eate Diagram

Import Diagram from =i

Alternatively, you can select File » New Diagram from the main menu, or
you can click [Create Diagram| in the toolbar. The Input window opens.

2 Enter Donations in the Diagram Name box and click [OK]. The empty Donations
diagram opens in the Diagram Workspace area.

3 Expand the Diagrams folder to see the newly created Donations diagram.

Getting Started Charitable Giving Example
—HE Data Sources

L] potoR_Raw_DATA,
= 5] Diagrams

l—@' Dorations

| Model Packages:

4 Click the diagram icon next to your newly created diagram and notice that the
Properties panel now shows properties for the diagram.
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Property “alue
Inl ERES
Harne Donations
Status Cipen
MHotes
History

Other Useful Tasks and Tips

Explore the node tools that are organized by the SEMMA process on the toolbar.
When you move your mouse pointer over a toolbar icon, a tooltip displays the
name of each node tool.

Explore the Toolbar Shortcut buttons that are located to the right of the node tool
icons.

Note that the Properties panel displays the properties that are associated with the
project that you just created.

From the main menu, select Help » Contents or, alternatively, press the F1 key.
Browse the Help topics.

To specify model results package options or to customize the appearance of your
Enterprise Miner GUI, select Options » Preferences from the main menu.

You can also use the View menu items to open the Program Editor, Log, Output,
and Graph windows as well as to open SAS tables and to set the Properties panel
to show the advanced options.
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Overview of This Group of Tasks

These tasks develop the process flow diagram that you created in “Create a Diagram”
on page 35. The Input Data node is typically the first node that you use when you
create a process flow diagram. The node represents the data source that you choose for
your data mining analysis and provides metadata about the variables. The other nodes
that you use in this chapter show you some typical techniques of exploring and
modifying your data.

Identify Input Data

In this task, you add an Input Data node to your process flow diagram.

1 Select the DONOR_RAW_DATA data source from the Data Sources list in the
Project panel.

2 Select the sample tab and drag the DONOR_RAW_DATA data source into the
Diagram Workspace.
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Enterprise Miner - Getting Started Charitable Giving Example
File Edit ‘iew Actions Options Window Help

Ol = B =]
Sample Explorel Modify Mndell Assessl Util'rtyl Credit Scoring
Getting Started Charitable Giving Example ... Donations M [=] 3
=HE| Data Sources
L] noNOR_Rawi_DaTa
[={2z] Diagratns ==y
I—@ Darations ..
F| Model Packages DOMOR_RaW_
Al Users DATA
s, 4
Propetty Walue
ID EMNE
Mame Donations
| |Status Cpen
Motes
History
s 4
biagram Donstions opened M Connected to SASMain - Logical Workspace Server

Note: Although this task develops one process flow diagram, Enterprise Miner
enables you to open multiple diagrams at one time. You can also disconnect from and
reconnect to a diagram if you have also configured the Enterprise Miner application
server. Other users can also access the same project. However, only one user can open a
diagram at a time. A

Generate Descriptive Statistics

As you begin a project, you should consider creating summary statistics for each of
the variables, including their relationship with the target, using tools like the
StatExplore node.

In this task, you add a StatExplore node to your diagram.

1 Select the Explore tab on the toolbar at the top left and select the StatExplore
node. Drag this node into the Diagram Workspace. Alternatively, you can also
right-click the Diagram Workspace and use the pop-up menus to add nodes to the
workspace.

Enterprise Miner - Getting Started Charitable Giving Example
File Edit “iew Action: Ophtion: ‘Window Help

= #] sl sl & i;Lﬂ_hl B
E%IMI Mad SlatE:(plme I I

Ii B2l Getting Started Charitable Giv Generate summary and association statistics. N

2 Connect the DONOR_RAW_DATA Data Source node to the StatExplore node.

Fum
——
E‘l:' e
DOMOR_RAW_ StatExplore

DATA
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3 Select View » Property Sheet » Advanced.

Enterprize Miner - Getting Started Charitable Giving Example
File Edit | ¥iew Actions Options “Window Help
Froperty Sheet

[#] Program Editor Ctil+i+P Ry
@_E @ Log Chrl+Al+L Hide

Output Ctrl+lte0)
@,j Graphs Chrl+Al+G
Takle... Chrl+alt+T

Refresh Project Chel+Alt+F

4 Select the StatExplore node to view its properties. Details about the node appear
in the Properties panel. By default, the StatExplore node creates Chi-Square
statistics and correlation statistics.

Note: An alternate way to see all of the properties for a node is to double-click
the node in the toolbar at the top left of the application. A

5 To create Chi-Square statistics for the binned interval variables in addition to the
class variables, set the Interval Variables property to Yes.

Propetty | Walue |

Maode D Stat |«
Imported Data
Exported Data

ariables
Use Segment Variahles
“ariahle Selection
iHide Rejected Yariahles 25
“Murnber of Selected Yariabl 000

BlChi-Sguare Statistics
|Chi-Square es
“Interval WYariahles Wes -
Mumhber of Bins

= Mo

HCorrelations [fes
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6 Right-click the StatExplore node and select Run. A Confirmation window appears.
Click [Yes]. A green border appears around each successive node in the diagram as
Enterprise Miner runs the path to the StatExplore node.

m} m} m}
[
' o PHERPION b\ ariables..

DOMNOR_RAW Y Update

DATA
Ef Results.. !

g4 Create Model Package. ..
@ Export Path az 545 Program

Cut
Copy

Delete
Rename
Select Al
Select Modes

Connect Modes

Note: An alternate way to run a node is to select the Run icon on the upper
right-hand side of the toolbar to run the path from the Input Data node to the
selected node on the diagram.

If there are any errors in the path that you ran, the border around the node
that contains the error will be red rather than green, and an Error window will
appear. The Error window tells you that the run has failed and provides
information about what is wrong. A

7 A Run Status window opens when the path has run. Click [Results]. The Results
window opens.
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A Generate Descriptive Statistics

B! Results - StatE xplore [_ O] ]
File Edit “iew ‘window
o el =1 s 3
1l Chi-Square Plot [_TO] %]
Target = TARGET_B
015
inm—
3
E
2]
©ops ] HH
L o s s e e e | T \ T {W[w(w{W{}[}{W(W{](](W(W[](](T(T[j(wrwﬁwﬁwrwrjﬁwﬁwrjrjr?
1 3 5 7 1 13 35 37 39 43 45
2 4 ] g 10 12 16 20 22 24 26 30 32 34 36 38 40 42 44 46
Ordered Inpu!s
5
: 3
2
3
4
5 Varisble Summary
(3
7 ROLE LEVEL COUNT
8
9 In NOMINAL 1
10 INPUT BINART 4
11 INPUT INTERVAL 36
12 INPUT HOMINAL &
13 REJECTED INTERVAL 1
14 BREJECTED HOMINAL 1
15 TARGET BINART 1 =
d o

4

The Chi-Square plot highlights inputs that are associated with the target. Many of

the binned continuous inputs have the largest Cramer’s V values. The Pearson’s
correlation coefficients are displayed if the target is a continuous variable.

Note:

right-hand side of the toolbar. A

8 Maximize the Output window. The Output window provides distribution and

An alternate way to view results is to select the Results icon on the upper

summary statistics for the class and interval inputs, including summaries that are
relative to the target.

0. |
E§ Output HEEE
62 Interwal Variable Summary Statistics Al

(maximum 500 wariables printed)

Variahle

CARD_PROM_12
DONOR_ASE

FILE_AVG_GIFT
FILE_CARD_GIFT

INCOME_GROTP

LAST_GIFT_iMT
LIFETINE_AVG_GIFT_AMT
LIFETINE_CARD_FROM
LIFETINE_GIFT_AMOUNT
LIFETINE_GIFT_COUNT
LIFETINE_GIFT RANGE
LIFETINE_MiX_GIFT_AMT
LIFETINE_NIN_GIFT_AMT
LIFETIME_FROM
MEDIAN_HOME_VALUE
MEDIAN_HOUSEHOLD _INCOME
MONTHS_SINCE_FIRST GIFT
MONTHS_SINCE_LAST GIFT
MONTHS_SINCE_LAST FROM RESP

4 |

ROLE Hean
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INPUT 5§.92
INPUT 1Z.86
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INPUT 3.91
INPUT 16.55
INFUT 1Z.88
INPUT 18.67
INPUT 104.43
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INPUT 11.59
INPUT 19.21
INFUT 7.62
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INPUT 341.97
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Hon

Missing
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19372
191z6

[

Misszing

o
4795
o
o
4392

== R R e e R Y = Y Y = =
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9 Scroll down to the Interval Variables Summary Statistics section. The

Non-Missing column lists the number of observations that have valid values for
each interval variable. The Missing column lists the number of observations that
have missing values for each interval variable.

Several variables such as DONOR_AGE, INCOME_GROUP,
WEALTH_RATING, and MONTHS_SINCE_LAST PROM_RESP have missing
values. The entire customer case is excluded from a regression or neural network
analysis when a variable attribute about a customer is missing. Later, you will
impute some of these variables using the Replacement node.

Notice that many variables have very large standard deviations. You should
plot these variables in order to decide whether transformations are warranted.

10 Close the Results window.

Note: If you make changes to any of the nodes in your process flow diagram
after you have run a path, you need to rerun the path in order for the changes to
affect later nodes. A

Create Exploratory Plots

Enterprise Miner enables you to generate numerous data visualization graphics in
order to reveal extreme values in the data and to discover patterns and trends. You use
the MultiPlot node to visualize your data from a wide range of perspectives. With
MultiPlot you can graphically explore large volumes of data, observe data distributions,
and examine relationships among the variables. The MultiPlot node uses all of the
observations for plotting.

In this task, you add a MultiPlot node to your diagram.

1 Select the Explore tab from the node toolbar and drag a MultiPlot node into the

Diagram Workspace. Connect the StatExplore node to the MultiPlot node.

E___ .‘:—QE }‘%‘

DOMOR_RAW StatExplare hultiPlat
DATA

Select the MultiPlot node in the Diagram Workspace. In the Properties panel, set
the Type of Charts property to Both in order to generate both scatter and bar
charts.

Property | Walde I
Mode 1D Plot ||
Imported Data
Expaorted Data
atiahles
Type of Charts

In the Diagram Workspace, right-click the MultiPlot node, and select Run.

4 After the run is complete, select Results from the Run Status window.
5 In the Results window, maximize the SAS Graphs window.
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! Results - MultiPlot
File Edit View ‘Window

A Partition the Raw Data

IS = E ]
SAS Graphs

5000
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(IjE,) 1008 _________ e Hmaeiisleselicsis e
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Click [First], [Previous]|, or [Next| at the bottom of the window to scroll through the

graphs. You can also view a specific graph by selecting the variable on the

selection box to the right of [Last].
You will notice several results in the graphs.

O One value for the variable DONOR_GENDER is incorrectly recorded as an A.

0 There are several heavily skewed variables, such as FILE_AVG_GIFT,
LAST GIFT AMT, LIFETIME_AVG_GIFT AMT,
LIFETIME_GIFT_AMOUNT, MOR_HIT RATE, PCT _ATTRIBUTE], and

PCT_OWNER_OCCUPIED. You might want to consider a log transformation

later.

0 Increasing values of LIFTIME_CARD_PROM, RECENT_RESPONSE_PROP,

LIFETIME_GIFT_AMOUNT, LIFETIME_GIFT_COUNT
MEDIAN_HOME_VALUE, MEDIAN_HOUSEHOLD_INCOME,
PER_CAPITA_INCOME, and RECENT_STAR_STATUS tend to be more
associated with donors and are also heavily skewed. You might want to

consider a bucket transformation that will be relative to the relationship with

target.

o Other variables, such as MONTHS_SINCE_LAST_PROM_RESP and

NUMBER_PROM_12, show some good separation of the target values at both

tails of the distribution.

6 Close the Results window.

Partition the Raw Data

In data mining, one strategy for assessing model generalization is to partition the
data source. A portion of the data, called the training data, is used for preliminary
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model fitting. The rest is reserved for empirical validation. The hold-out sample itself is
often split into two parts: validation data and test data. The validation data is used to
prevent a modeling node from over-fitting the training data (model fine-tuning), and to
compare prediction models. The test data set is used for a final assessment of the
chosen model.

Enterprise Miner can partition your data in several ways. Choose one of the
following methods.

O

By default, Enterprise Miner uses either simple random sampling or stratified
sampling, depending on your target. If your target is a class variable, then SAS
Enterprise Miner stratifies the sample on the class target. Otherwise, simple
random sampling is used.

If you specify simple random sampling, every observation in the data set has the
same probability of being included in the sample.

If you specify simple cluster sampling, SAS Enterprise Miner samples from a
cluster of observations that are similar in some way.

If you specify stratified sampling, you identify variables in your data set to form
strata of the total population. SAS Enterprise Miner samples from each stratum
so that the strata proportions of the total population are preserved in each sample.

In this task, you use the Data Partition node to partition your data.

1

2

3

Select the sample tab from the node toolbar at the top left of the application. Drag
a Data Partition node from the toolbar into the Diagram Workspace.

Connect the DONOR_RAW_DATA Data Source node to the Data Partition node.

llt 3!1!3 = %l‘

DOMOR_RAW StatExplore MultiPlot
DATA

Drata Padition

Select the Data Partition node in the Diagram Workspace. Details about data
partitioning appear in the Properties panel.

Note: If the target variable is a class variable, the default partitioning method
that Enterprise Miner uses is stratification. Otherwise, the default partitioning
method is simple random. A

In the Properties panel under the Data Set Percentages section, set the following
values:

O set Training to 55

O set Validation to 45

O set Test to O
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Property Walue
Fode D Fart
Imported Data
Exported Data

ariables
Paditioning Wethod Default
Fandom Seed 12344
EData Set Percentages
}-Training 55.0
| Hvalidation 45.0
| HTest 0.0

In the Data Set Percentages section of the Properties panel, the values for the
Training, Validation, and Test properties specify how you want to
proportionally allocate the original data set into the three partitions. You can
allocate the percentages for each partition by using any real number between 0
and 100, as long as the sum of the three partitions equals 100.

Note: By default, the Data Partition node partitions the data by stratifying on
the target variable. This is a good idea in this case, because there are few donors
relative to non-donors. A

5 Run the Data Partition node.

Replace Missing Data

You use the Replacement node to generate score code to process unknown variable
levels when you are scoring data, and to interactively specify replacement values for
class levels.

In this task, you add and configure a Replacement node in your process flow diagram.

1 From the Modify tab of the node toolbar, drag a Replacement node into the
Diagram Workspace and connect it to the Data Partition node.

e

=

DOMNOR_RAW_ StatExplore hLtiF1ot
DATA
Data Partition Replacement

2 Select the Replacement node. On the Properties panel, select the ellipsis button to
the right of the variables property to explore any of the variables in the input
data set. The Variables - Replace window opens.
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Propetty Walue

Maode D Replace

Imported Data
Exparted Data
ariables
Feplacement Editor
Linknown Levels lgnore

Hide Mo |

3 In the Variables - Replace window, select the variables SES and URBANICITY,
and then click [Explore|. The Explore window opens.

Note: If is dimmed and unavailable, right-click the Data Partition
node and select Run. A

[Matne | Lse | Report | Role |
FCT_ATTRIBUTE4 es Mo Input ;I
FCT_OWNER_OCCUPRIED Yes Mo Input
FEP_STAR Yes Ho Input
FER_CAFRITA_INCOME es Mo Input
FUBLISHED_FHOME Yes Mo Input
RECENCY_STATUS_96MK fes Mo Input
RECENT_AWG_CARD_GIFT_AMT es Mo Input
RECENT_AWG_GIFT_AMT Yes Mo Input
RECENT_CARD_RESPOMSE_COUMNT Yes Mo Input
RECENT_CARD_RESFOMSE_FPROF  ¥es Mo Input
RECENT_RESFOMSE_COUNT Yes Mo Input
RECENT_RESFOMNSE_FROP Yes Mo Input
RECEMNT_STAR_STATLIS es Mo Input
SES Yes Ho Input
TARGET B Yes Mo Target
TARGET D Mo Mo Rejected
LIRBAMICITY Yes Yes Ingut

EALTH_RATIMNG Yes Ho Input hd
i1 i
Explare... D\l QK I Cancel | Help |

4 In the Explore window, notice that both the SES and URBANICITY variables
contain observations that have missing values. The observations are represented
by question marks. Later, you will use the Impute node to replace the missing
values with imputed values that have more predictive power.
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2l
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[

5 Select the bar that corresponds to missing values (SES = “?”) in the SES
histogram. Notice that when observations display missing values for the variable
SES, the observations also display missing values for the variable URBANICITY.
The graphs interact with one another.

-~ Explore - EMWS _Part_TRAIN H=] E3
File View Actioh: ‘Window
=[O 4]
¥+ Sampl Properties =57 1 ses N 1ol
5,000
Sample Method Top 4,000
Fetch Size Default Z
Random Seed 12345 53,000—
Fetched Raws 10000 =
2 2 000
[V
1,000
o 'IIIII‘
? 3 1 4
Apply | Plat... | SES
Mw/S.Part_TRAIN I = B ||V URBARICIN =10| x|
Obis # SES UREAMICITY
i 5 2,000
307 7 s
313 u
312% 7 E1 500
3131 S g
3141 T & 1,000 1
357 ? i
362 C 500
37z C
381 5 o /77
3192 C ;
o = 7 R 5 [ T
3217 7 | URBANICITY
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6 Close the Explore window.
7 Click to close the Variables window.

8 In the Replacement node Properties panel, select the ellipsis button to the right of
the Replacement Editor property.

Property “Walue
MHade 1D Replace

Imported Data
Exported Data

ariables
Replacement Editor
IInknown Levels lgnare N
Hide Mo

9 When you are prompted to create a replacement data table, click [Yes].

Create Replacement Table |
@ Mo replacement data table is found.
Do you want to create the table?

o |

The Replacement Editor window opens.

Note: By default, Enterprise Miner replaces unknown levels using the Unknown
Levels property in the Properties panel. The choices are Ignore, Missing and
Mode (the most frequent value). Ensure that the Unknown Level property is set to
Ignore. A

Property | “alue |

FHode D Feplace |
Imported Data
Expaorted Data

ariables
Replacement Editor
LInknown Levels
Hide

10 Scroll through the data table in the Replacement Editor window. Observe the
values for the variable levels of SES and URBANICITY. When one of these
variable levels displays a question mark (?) in the char Raw value column, enter
_MISSING in the Replacement Value column for that row.
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Replacement Editor
ariable | Lewel Frecuency Type Char Rasee v... [ Murn Rawe V... Replacemen{...l
RECEMCY_ST...[E 248 C E . ;I

RECEMCY_ST... )L 44 C L

RECEMCY_ST...| _UIMKMOWAN_ C _DEFAULT_
SES 2 5055 C 2

SES 1 3274 s 1

SES 3 1821 s 3

SES 7 245 e 7 _MISSING_
SES 4 223 i 4

SES Uk ORAR C . _DEFALLT_
TARGET_B 0 7990 Wl 0.0

TARGET_B 1 2664 Wl 1.0

TARGET_B _ UMM i _DEFALLT_
URBAMCITY |5 2459 C =

URBAMCITY  |C 223 C C

URBAMCITY T 2174 C T

URBAMCITY R 2169 C R

URBAMCITY U 1373 C (]

URBAMCITY |7 248 s 7 llﬁm
URBAMCITY | UMKMOWAN_ s |_DEFAULT_ hd

Reset | Ok I Cancel | Help |

11 Click [OK].
12 Right-click the Replacement node and select Run.

.

=

DOMNOR_RAW_ StatExplore wiultiPlot
DATA
o o o
Data Partition DRepIacDemen Edit Variables.
Y Update
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‘% Create Model Package...
Eﬁl Export Path as SAS Program

Cut
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Rename
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Overview of This Group of Tasks

These tasks introduce you to the Decision Tree node and to the Tree Desktop
Application. You use the Decision Tree node to model the data. You use the Tree
Desktop Application to explore and evaluate the decision tree as you develop the tree.
You also learn to perform typical interactive tasks.

Basic Decision Tree Terms and Results

An empirical tree is a segmentation of the data. Enterprise Miner creates an
empirical tree by applying a series of simple rules that you specify. Each rule assigns
an observation to a segment, based on the value of one input. One rule is applied after
another, resulting in a hierarchy of segments within segments. The hierarchy is called
a tree, and each segment is called a node. The original segment contains the entire data
set and is called the root node of the tree. A node and all its successors form a branch of
the node that created it. The final nodes are called leaves. For each leaf, a decision is
made and applied to all observations in the leaf. The type of decision depends on the
context of the data mining problem. In this example, the decision is simply the predicted
value. The path from the root to the target leaf is the rule that classifies the target.
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Tree models readily accommodate nonlinear associations between the input variables
and the target. They offer easy interpretability, accept different data types, and handle
missing values without using imputation.

In Enterprise Miner, you use the plots and tables of the Results window to assess
how well the tree model fits the training and validation data. You can benchmark the
accuracy, profitability, and stability of your model. The Decision Tree node displays the
following results:

0 A standard Cumulative Lift Chart for the training and validation data. This chart

provides not only lift values but also provides a quick check as to whether the tree
model is reliable. If the tree is unreliable, then none of the numbers or splits is
valuable. Trees can be unreliable when they are applied to new data, so you
should always evaluate the tree using both the validation and test data.

A Leaf Statistics bar chart in which the height of each bar equals the percentage
of donors in the leaf for both the training and validation data. The order of the
bars is based on the percentage of donors (1’s) in the training data. Use the scroll
bar at the top to show additional leaves. You should also look for consistency in
each leaf with regards to the training and validation data.

The Tree Diagram (in a window labeled Tree) that shows how the data splits into
subgroups.

Fit Statistics for both the training and validation data.

The Tree Map represents a compact graphical representation of the tree. The
nodes have the same top-to-bottom, left-to-right relationship as the traditional tree
diagram. The width of a node is proportional to the number of training cases in
the node. Colored rectangles represent individual nodes of the tree: larger
rectangles represent the nodes that contain more cases. The nodes are colored
according to the values of a statistic. By default, a node’s color reflects the
percentage of the target event in the node. For categorical targets, color represents
the proportion of the target value in the training data set that is assigned to this
node. For an interval target, color represents the average target value in the
training data that is assigned to this node.

The Output window contains information such as variable importance, tree leaf
report, fit statistics, and a classification matrix.

Create a Decision Tree

In this task, you use the Decision Tree node to build a decision tree using your
partitioned data.

1 Drag the Decision Tree icon from the Model tab of the toolbar into the Diagram

Workspace.

2 Connect the Replacement node to the Decision Tree node.

of ._H_wﬂ..

DOMORE_RAWL  StatBExplore  MultiPlot

DATA
Q—@Q—l“ L]

Data Padition Replacement Decision Tree
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3 Select the Decision Tree node in the Diagram Workspace. The Properties panel
indicates how each Decision Tree node property is configured.

4 Set the Decision Tree node properties as follows:

0 Set the Maximum Branch to 4 in order to allow the Tree node to create up to
four-way rules. The Decision Tree node creates binary splits by default.

O Set the Leaf Size to 8 in order to ensure that each leaf contains at least 8
observations.

0 Set the Maximum Depth to 10 in order to potentially grow a bushier tree.

0 Set the Number of Surrogate Rules to 4 in order to handle missing values
in the data.

0 Keep the Splitting Rule Criterion property in its Default (Chi-Square) setting.
Note: The Assessment Measure property is automatically set to Decision by

default because you have defined a profit matrix. The Decision Tree node will
choose the tree that maximizes profit in the validation data. A

Property I Yalue I
Made (D Treg |A
Impored Data
Exported Data

ariahles
Interactive
“|Criterion Default
"|Significance Level n.z2
Wissing Walues Ise in search
Use Input Once [
Maximum Branch 4
haximum Depth 10
Minirmum Categorical Sizels

l_

‘ILeaf Size [
sumber of Rules A
“Humber of Surrogate Ruled

-[Spalit Size
'EM
F|Exhaustive 5000

“Mode Sample 5000 =
E
“lethod mesessment
Mumber of Leaves 1
‘Wesessment Measure Decision

5 Right-click the Decision Tree node in the Diagram Workspace and select Run.



54 Create a Decision Tree A Chapter 4

6 A Run Status window appears when the Decision Tree run has been completed.
Click [Results]. The Results window opens.

@& Results - Decision Tree M=l B3
File Edit View ‘Window

j5) el =) 7

=[Ol ]
'; 01
B
=
E 0o
-3 1 3 g 11 14 17 19 25
5 2 4 10 13 15 18 23 26
Decile Leaf Index
[===TRAIN — ~—VALIDATE
m%1 B%VI
== Tree Map P8 =] ES3 || € Fit Statistics =10l x|

TARGET Fit statistics | Statistics La... Train
TARGET_E _MOBS_ Sum of Fregu... 10654 |
TARGET_B LN Sum of Case ... 21308
TARGET_B _MISC_ Mizclazsificat... 0250047
TARGET B M Maimum &h... 0916667
TARGET_B _S5E_ Sum of Sgua... 3839.395
TARGET_E _ASE_ Average Sou.. 0180136
TARGET B _RA&SE_ Rodt Averag... 0424483
TARGET_E _Div_ Divizar for ASE 21308
TAFGFT (2] DET Tital nFrTﬁﬁ 1nR5d T

4 »
—icix]

l\:|
3

Varigble Sunmary

EROLE LEVEL COUNT

FREQUEMNCY_STATUS_G7 MK = THETT BINART 4 -
K1 L _'l_I A _'I_I

Wom -l o s W

The Score Rankings Overlay: TARGET_B chart shows that a consistent trend is
achieved on both the training and validation data. Although the lift values
decrease quickly, the tree does seem to be stable.

The Fit Statistics table shows that the average profit of the training and
validation data is about 27.7 and 25.4 cents, respectively.
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7 Move your mouse over the different points of either the training or validation line

in order to reveal the various lift values on the Score Rankings Overlay:
TARGET_B chart.

5 Results - Decision Tree

O] ]
File Edit Wiew ‘Window

o] et [f=] e

Score Hankings Overlay: TARGET_B

Select Chart: petlyiE= (g
E 204
= \
@
-
= DECILE = 40
= LIFTC = 1338891
1.5
= DATAROLE = TRATN
(] \\[\
1.0+
T T T T T T
0 20 40 60 80 100
Decile
===TRAIMN ==\ALIDATE

8 Select the Cumulative Lift chart and then click at the top left of the Results
window in order to display a table of the lift values,

Note: You can highlight rows in the table and then use Copy to paste the
contents to another application such as Microsoft Word or Excel. You can also copy

graphs the same way. This feature is common to most of the Enterprise Miner
tools. A
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Score Rankings Overlay: TARGET_B - EMWS Tree EMRBANE M 5l E3
Target vari... Data Role Decile | Cumulative ... | Best Curnul...

TARGET_B TRAIR ] ] ] =
TARGET_B TRAIM 1 a 11.70904 100
TARGET_B TRAIMN 1 10 18.65493 100
TARGET B TRAIM 1 15 253084 100
TARGET_B TRAIM 1 20 2198187 100
TARGET_B TRAIM 1 25 535.23469 100
TARGET_E TRAIM 1 30 43 593491 100
TARGET_B TRAIR 1 a5 48 BSEET 100
TARGET_B TRAIM 1 40 53.55565 100
TARGET_B TRAIMN 1 45 55.45463 100
TARGET B TRAIM 1 a0 E3.35362 100
TARGET_B TRAIR 1 55 E3 2526 100 |
TARGET_B TRAIM 1 G0 F2amom 100
TARGET_E TRAIM 1 ES TTE337S 100
TARGET_B TRAIM 1 Eil] 822965 100
TARGET_B TRAIM 1 75 86907 M 100
TARGET_B TRAIM 1 g §9.59577 100
TARGET_E TRAIM 1 G5 9283403 100
TARGET_B TRAIR 1 an o5 7F22a 100
TARGET_B TRAIM 1 95 95 .07e01 100
TARGET_E TRAIM 1 100 100 100
TARGET_B ValLIDATE 0 0 oL

9 Close the Score Rankings Overlay table.

10 Because you defined a profit matrix for the Donor data, you should base your
evaluation of the model on profit. To display profit, rather than lift, on the Score
Rankings plot, follow these steps:

a Maximize the Score Rankings Overlay: TARGET_B chart.
b Right-click the background of the plot and select bata Options.
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Select Chart: ICumuIative Lift

2.0

Cumulative Lift

1.0+

=]

Graph Froperties. ..

Action Mode ]

Copy !

™ =1 B3

G0 a0

Decile

[=—TRAIN

——VALIDATE |

100

¢ Scroll down the list of variables and set the Role for PROFIT to Y.
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Raoles | ".-"'-."hEI’EI ST |
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REARMICITY ... Mumeric Fepart: UREANICITY =R
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™ Ao multiple rale aszighments

_o |

d Click .

11 Restore the Score Rankings chart to its original size.
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! Results - Decision Tree M=l E3
File Edit iew ‘“window

S s = e 3

Score Rankings Overlay: TARGET_B

Select Chart:  LSEINE RN E
1.0
]
=
o
[
o
0.5+
0.0+
T T T T T T
0 20 40 G0 20 100
Decile
==TRAIMN —="ALIDATE

12 Select the Leaf Statistics plot and select the bar that corresponds to Leaf Index =
3. When you select the bar, note that the corresponding node is highlighted in
both the Tree Map and Tree Diagram. The Leaf Statistics plot, Tree Map, and Tree
Diagram are interactive, dynamically linked plots. This feature is especially useful
when you are using the Tree Map to isolate interesting nodes in a large tree.
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The largest nodes with a high percentage of donors are in the lower left quadrant.
Select a node from the lower left quadrant and examine the corresponding node in

the Tree view.
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&0 Results - Decision Tree M= 3
File Edit ‘“iew ‘wWindow
g5 e = ][R
5core Rankings Dve =1Ool x| Leaf Statistics | [=] E3
Select Chart, [Curmulative Litt =l 03
0.2 !
01 :
00 III
1 3 g 11 14 17 19 25
2 4 10 13 15 18 23 26
—TRAIN __ —VALIDATE | Leaf Index
O%1 B%Y1
=101 I/ =10/x]

TARGET | Fit statistics | Statistics La.| Train ¥ | Vai
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TARGET_E DI _ Divisor for ASE 21308
TARGET_E _MOBS_  Sum of Fregu.. 10854
TARGET_E | _DFT_ Total Degres... 10654
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13 Move your mouse pointer over the node to display node statistics for both donors
(1) and non-donors (0). By default, each node in the Tree Diagram displays the
predicted target value percentages and counts, which in this leaf is 0.

14 Maximize the Tree window and explore the Tree diagram. Note that the line

thickness for each split indicates the number of cases in each underlying node.
Right-click the plot background and examine the different View menu item

settings.
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Mode Size E
T =T FREQU...
Link i dth ] | . -
Graph Froperties... MONTH... PEP_ST...
Action W ode » —L —
Copy == 5 = 45 1] 1
H| @ Wl FILE_AV...
Toolz » v Chart tipz I —_—
v Legend wom= 128 == 101358 = 10135
v |
J
@ oz MUMEE
9 B3
== fm < 135 == 1345
E v Fit to page E -
INCOME... FER_CA...
— —
== 2/ <= 325§ == 2693, [11209.5..=11209.5
RECERM...
— [

15 Select View » Model » English Rules from the Results window menu in order
to view the English Rules.

ot Results - Decizsion Tree

File Edit | Wiew ‘window

E“ | _ Properties

S45 Resultz

Sconng

Azzeszment
hodel

Mode Siz

A T T r v

Leaf Statistics

7 Table Englizh Rules
Link witid

e Graph *izard Tree
o e Tree Map

[teration Plot
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B Englizh Rules _ O]
FS

1 IF FREQUENCY STATUS STNE EQUALS 3
2 THEN
i NODE : 3
4 n : 1680
5 1 : 6. 7%
f 0 : 93. 3%
7
g IF FREQUENCY STATUS STNE EQUALS 2
a THEN
10 HOLE : 4
11 n : 23471
12 1 : 4.9%
13 0 : 95.1%
14
15 IF MONTH3 3INCE LAST GIFT < 9.5
1a AND FREQUENCY STATUS S7THNE EQUALS 4
17 THEN
13 NODE : [
13 n : 46
20 1 : 25.0%
21 0 : 15.0% x
« il

16 Select View » Assessment » Adjusted Classification Chart: TARGET_B
from the Results window menu to view the Adjusted Classification chart.
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Adjusted Classihication Chart: TARGET_B
Data Fole = TRAIM Data Role = YALIDATE
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Notice that none of the donors has been correctly classified in either partitioned
data set. However, the goal is centered on isolating the set of candidate donors
that will maximize profit. Even small average profit values of about 26 cents will
result in a significant total profit, especially when applied to a large customer base.

17 Examine the Score Code. From the main menu, select View » Scoring » SAS
Code. You will notice these entries:

O Publish Score Code is the SAS score code that you can use to score data in
applications that run outside the Enterprise Miner environment.

0 Flow Score Code is the SAS score code that contains potential warnings and
error messages about the targets in the process flow diagram.

0 Enterprise Miner also produces PMML, an XML representation of a data
mining model. SAS PMML is based on the Data Mining Group PMML
Version 2.1, that has significant extensions to support the data types,
transformations, and model definitions that SAS requires. These files can be
used with PMML scoring engines that support PMML Version 2.1.

18 Close the Tree Results window.

Create an Interactive Decision Tree

About the Tree Desktop Application

SAS Enterprise Miner Tree Desktop Application is a Microsoft Windows application
that implements decision tree methodology for data mining. The application functions
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in either viewer mode or SAS mode. Viewer mode enables you to interactively browse
decision trees that are created with the Enterprise Miner Tree node. SAS mode enables
you not only to browse the results, but also to use the software as a complete
application by providing automatic and interactive training modes. After you train the
tree interactively with the application, you can also view the Java tree results.

Invoke the Application

In this task, you will use Tree Desktop Application to assess the decision tree model.

1 Drag a second Decision Tree node from the Model tab on the toolbar into the
Diagram Workspace and connect it to the Replacement node.

: B v
o Tife—>olzho
DOMOR_RAW N StatBxplare MLIltiP ot
DATA g';h'

Decision Tree

£30

Decision Tree (2

Data Padition  Replacement

Note: To organize the diagram layout, right-click the background of the Diagram
Workspace and select Layout » Horizontally as shown below. Continue to use
this feature to organize the layout as the diagram becomes more complex. A

o

DOMOR_RAW Y StatExplore mutiFlot

DATA ;‘;,;If
Add Mode , : Decision Tree
Paste Data Partition Replacement

Select Al g::i;"’
Select Modes o
I Decision Tree (2

£oom ] Wertically

2 Select the second Decision Tree node and set the following Tree node properties
in the Properties panel:

0 Set the Number of Rules to 10. This property controls how many candidate
splitting rules are shown during interactive training.

O Set the Number of Surrogate Rules to 4.
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Property

Walue

Mode 1D

Tree2

Irmparted Data

Exported Data

ariables
Interactive
“|Criterion Default
|Significance Level n.z2
hissing Walues IJse in search
Use Input Once M
-aximum Branch 2
Waximum Depth ki

|Leaf Size

minimum Categorical Sizel
B

5

umber of Rules

10

[Murnber of Surrogate Ruled [
hA]

-Split Size
Eepitseacn

Invoke the Application

3 Click the ellipses button to the right of the Interactive property to invoke
theTree Desktop Application.

Property

I Walue

Mode 1D

Treel

Imported Data

Exported Data

ariahles

Interactive

Note: If you are asked to update the path before the application is invoked,

click LA

predecessor nodes have been run.

Decizion Tree (2}
o o

I ——

Edit Yariables...

Run

EH Results...

% Create Model Package...
Eil Ewport Path as SA5 Program

Cut
Copy

Delete

Rename

Select all
Select Modes
Cohnect Modes

Right-click the Decision Tree node and select Update in order to ensure that all

65
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5 Click from the Status window when the path is updated.
By default, the root node of the tree diagram and the tree map are displayed.

& EMWS_Tree2 BROWSETREE[EMWS PART_TRAIN] - SAS Enterprise Miner Tre._. [Hi[=] E3

File Edit Model Train “iew Optiohz ‘Window Help

Tree - EMWS Tree?_ BROWSETREE M= E
seatiseic  Training |
| 1: z5% !
! 0: 755
| M in node: 10654
TZ Tree Map - EMW! _|EI|5|

IE'&. Tiee -EMWS. 58 Tree Map-Eﬂ

For Help, presz F1

| Traity Interactively |Priors Mot Applied | 2

Note: If the tree map is not displayed, select View » Tree Map from the
window menu. Select Windows » Tile window menu to arrange your windows.
You can also press the F1 key to open the TDA Help. 2

Assign Prior Probabilities

1 Examine the messages in the lower right-hand corner of the window. Note the
message Priors Not Applied. The message indicates that the probabilities that

were defined earlier have not been applied to this view of the data.
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& EMWS_Tree2 BROWSETREE[EMWS PART_TRAIN] - SAS Enterprise Miner Tre._. [Hi[=] E3

File Edit Model Train “iew Optiohz ‘Window Help

Tree - EMWS Tree?_ BROWSETREE M= E
seatiseic  Training |
1: z5% !
! 0: 755
| M in node: 10654

TE Tree Map - EMW! _|EI|5|

IE'&. Tiee -EMWS. 58 Tree Map-Eﬂ

For Help, presz F1 | Traity Interactively |Priors Mot Applied | 2

2 Select Edit » Apply Prior Probabilities from the menu in order to apply the
prior probabilities that you defined earlier.

& EMWS Tree? BROWSETREE[EMWS PART_TRAIN] - SAS Enterprise Miner Tree Desktop Applic... [H[=] [E3

File | Edit Model Train “iew Options ‘Window Help
T Wit iz k
! Fieda [Cirl HEE P[=] B
Copy Chrl+C
Capy Entire Tiakile Statistic Training
1: 5%
Edit: Froperties a: 95%
v Apply Prior [ N in node: 10654
7= Tree Map - EMWS. o ] 3
| |
IE:}, Tree - EMWS. 5@ Tree Map - Eﬂ
Apply prior probabilities to all displayed statistics |Train Interactively |F'ri0rs Applied i

Note that the node counts are now adjusted for the priors. The message panel
at the bottom right verifies that the prior probabilities have been applied.

Statistic Training
25%

PE%
10554

|Train Interactively |Friors Not Applisd |
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Statistic Training
E%

S5%
10554

Train Interactively |Priors Applied |

Create the First Interactive Split

1 Right-click the root node of either the tree diagram or the tree map and select

Split Node.
Statistic Training
1: L%
o: 95
N in node: 10654 |
i K
Train
Erure

® Train Interactively
Wiew Results.

The Candidate Splitting Rules window opens, displaying the top ten variables,
which have been sorted by logworth. In this case, logworth is the negative log of
the p-value for the Chi-Square test. Good predictors have higher logworth values.

2 Select the variable FREQUENCY_STATUS_97NK in the Split Node window.

Split Node 1 |
"ariahble -Loalpl Branches Apply |
FREQUENCY_STATUS. 7 2 Edit Fule... |
LAST_GIFT_AMT 17.3 vl | = :
PEP_STAR 149 5| _LitalVaisbes.. |
RECEMT_RESPONSE_( 14.7 2 oK
LIFETIME_M&x_GIFT_¢ 14.0 2
FILE_&VG_GIFT 136 2
LIFETIME_AVG_GIFT A 136 2
RECENT_CARD_RESF 1219 2
RECEMT_RESPOMSE_f 125 2
RECENT_avG_GIFT At 123 2
|
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3 Click to define the first split.
The Tree Diagram shows the first split.

Statistic Training

1: L%

0: 35%

N in node: loeb4
i

FREQUENCYT STATUS STHNE

Statistic Training Statistic Training
1: 7% 1: 4%
0: 93% o: Q5%
N in node: 20E4 N in node: TE30

Add Additional Node Statistics

1 Right-click the background of the Tree Diagram, and then select Node
Statistics.

| Btatistic Training E Mode Stati

E ; 9?: 't Dizplay Test k
' W oin node: 10654 ¥ Display Node Probe
_____________ R

FREQUENCY STATUS 37HE Export as image. .

Tree YWiew Properties. ..

Zoom »
SipEiEaaEas Training Statistic Font...
1: 74 : :
[ ]
o: 933 . T.raln [nteractively
N in node: 2024 H in node- YWiew Results...

r

2 In the General tab of the Node Statistics window, select the becision and
Predicted Profit boxes and click [OK].
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Mode Statistics E |

Data sets v Display text
¥ Tiraiting I & alid st v Dizplay column labels
IV Display statistic labels

General | Targetl F'rn:nfit;"Lu:ussI Fnrmatl Rulez I

W M in node
™ Mode ID
[T Predicted value [ Percent comect
V¥ Decision ¥ Predicted profit

Mate: The predicted walue ignores profits.

The decizion iz the predicted value uzsing profits.

Changes will apply to Tree Yiew.
[ d&lso apply these settings to Local Tree and Tree Map

[k Cancel Apply

The Decision Tree displays the additional statistics.

i Decision: 1]
E Btatistic Training E
i 1: L1 I
| o: 5%
' N in node: 10654
i Profit: o.g5
e e ’

FREQUENCY STATIS 37NE

Decision: 1 Decision: 1
Btatistic Training Btatistic Training
1: % 1: 4%

o: Q3% o: 5%

N in node: S0E4 N in node: TEZ0
Profit: 0. &0 Profit: 0.11

Note: By default, the width of a line from a parent node to a child node
depends on the ratio of the number of cases in the child node compared to the
number of cases in the parent node. This distinction is useful when you are
examining a much larger tree and you hide the node statistics. A
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Shade the Nodes hy Profit

You can shade the nodes according to the expected profit value. By default, both the
Tree Map and the Tree nodes are shaded according to the proportion of the target event
in each node. Lighter shaded nodes indicate a greater frequency of non-donors.

1 Right-click the background of the Tree and select Tree View Properties.

i Decision: 1!
E Btatistic Training E
i 1: % !
i 0: 9E%
' N in node: 10654 1
LA lf]_:_n_f_lﬁ'_- _______ _D_'_Z_E: r Mode Statistics. .

FREQUENCY STATUS 27NE v [lizplay Text
v [lizplay Mode Probe

E = Export az image...
Decision: 1 Decision: —
Statistic Training Statistic Tree Yiew Properties.
1: 7% 1: Zaom k
0: 3% 0: Fant...
N in node: 2024 N in node:
Profit: a.&0 Profit: @ Train Interactively

Wiew Results. ..

2 In the Tree View Properties window, select Profit.

Tree Yiew Properties HE |
Mode Colars | Tree I Generall

Tree, Local Tree and Tree Map Mode Caolors

" One colar ||:| 'I

™ Propartion of target value |'|

L4

" Predicted target walue

™ Percent comectly predicted

* Profit

™ Decision Colors:
1 I |+ .
0.933333 I
(.36EEE7 [ ]
(I [ ]

Range 0.¥33333 I

0. GEEEET
b aximuinn; I 1.0000 0E
o 0533333
Minirnur: | 0.0000 0.4EG6E7 | _|LI
]

Intervalz: 16
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3 Set Range Maximum to 1.
4 Set Range Minimum to 0.
5 Click [OK].

In the Tree window, note that nodes that have higher expected Profit values
are shaded darker than nodes that have lower expected Profit values.

i Decision: 1 1.
E Statistic Training E
i 1: Ex
i 0: 9E% |
' N in node: 10654
i Profit: O.z&5 |
b e e e e oo _- _____________ 4

FREQUENCY STATUS 37NE

3

N
Decision: 1 Decision: 1
Btatistic Training Statistic Training
1: 7% 1: &%
0: Q3% o: 5%
N in node: 30E4 N in node: FE30
Profit: o.e&0 Profit: 0.11

Define the Second Split

1 Right-click the node that has 7,630 cases and select Split Node.

Deciszion: 1
Statistic Training
1: 5%
0: aL%
N in node: 10654
Profit: 0,25

||

FREQUENCY STATIE STNE

3 1
'
Decizion: 1 Decision: 1 ]
Statistcic Training Statistic Training w
1: 7% 1: 4%
0: Q3% 0: Q6% Train l‘\f
N in node: 2024 N in node: TE20 EHre
Profit: 0.&s0 Profit: 0.11

® Train Interactively
Wiew Fesults...

The Split Node window opens. Candidate rules are always shown for the node
that you choose. You control how many rules are displayed prior to invoking the
application.
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2 Select PEP_STAR as the splitting variable and then click [Apply].

Split Node 4 Ed |

"ariahle -Loglp] Branches Apply [: |
Edit Rule... |
FILE_CARD_GIFT hEZ 2 . i
MEDIAN_HOME _WALLIE 4.80 2 Ml
LIFETIME_GIFT_COUMN" 419 2 ak. |
LIFETIME_GIFT_RAMGE 4.04 2
LIFETIME_GIFT _aOLI 4.0 2
FREQUEMCY _STATUS 391 2
INCOME_GROUP 3.80 2
MUMBER_PROM_12 164 2
LIFETIME_PROM 361 2
| B

3 Click [OK]. The Tree appears as follows:

Decision: 1
Statistic Training
1: 5%
0: 953
N in node: 10654
Profit: O.zk&

L_|

FREQUENCY_ STATUS 37HE

3 1
I
Decision: 1 Decision: 1
Statistic Training Statistic Training
1: i 1: 4%
o: Q3% 0: Q6%
N in node: 024 N in node: 7830
Profit: 0. &0 Profit: 0.11
AS
PEP STAR
N |
I 1
u] 1
| ]
Lecision: 1 Decision: 1
Statistic Training Statistic Training
1: 3% 1: E%
0: 7% 0: 95%
N in node: 4641 N in node: zZ9a3
Profit: .oz Profit: O.zk&

Create a Multi-Way Split

1 To open the candidate splitting rules for the dark-shaded node (the node that has
3,024 observations), right-click the node and select Split Node.
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- -
Decisiomn: 1 m
Statistic Training ] bty
1: 7% Train
0: 23% Erume
N in node: 3024
Profit: o.s0 @ Train Interactively

o Yiew Fesults...

2 In the Split Node window, select the variable MONTHS_SINCE_LAST_GIFT and
then click [Edit Rule].

Split Node 3 |
Y ariable -Loalp] Branches Apply |
MONTHS_SINCE_LAST 7 02 A
LAST GIFT_AMT £ 85 2 4[§—|
FILE_CARD_GIFT 570 , _Lstalvaiabis.. |
PEP_STAR 497 5 aK. |
NUMEEF_PROM_12 453 2
C&RD_PROM_12 450 2
RECENT_&WG_GIFT_at 438 2
LIFETIME_M&3_GIFT_¢ 407 2
FILE_&VG_GIFT 398 2
LIFETIME_&VG_GIFT_a 398 2
| B

3 In the MONTHS_SINCE_LAST GIFT Splitting Rule window, enter 8 in the New
split point box and then click [Add Branch].

MOMTHS_SINCE_LAST_GIFT Splitting Rule |

Branch Split Point Missing Apply
1| = HIE
2 == 85| W Urida
Hesef
)4

Cancel |

M ew split point; Add Branch

Eemove Branch

Azzign mizzing value to branch: I 2 TI

4 Select Branch 2 (<8.5) and then click [Remove Branch].
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MOMTHS_SINCE_LAST_GIFT Splitting Rule |

Branch Split Point Missing Apply
1 = g8 r
kil
3 == 85| W
Reset
)4

M ew split point;

Cancel |

Sdd Branch

Femove Branch

Azzign mizzing value to branch: I 3 =

5 In the New split point box, enter 14 as the third split point and then click

Add Branch]|.
MONTHS_SINCE_LAST_GIFT Splitting Rule |
Branch Split Point Missing Apply
1 = g8 r
2 == g v rdo
Feset
]

M ew split point;

Add Branch

Eemove Branch

Azzign mizzing value to branch: I 2 TI

Cancel |

6 Click in order to create the modified three-way split.
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MOMTHS_SINCE_LAST_GIFT Splitting Rule |

Branch Split Point Missing Apply
1 = g8 [
AE 14 [C Uridd
3 == 14|
Reset

ak.

Cancel |

M ew split point; Sdd Branch
Eemove Branch |

Azzign migzing value to branch; | 3

The node that has 3,024 observations is split three ways.

3

Decision: il
Statistic Trainineg
1: 7%

0: S93%

N in node: 2024
Profit: 0.s0

MONTHS STINCE_LAST GIFT
|

"

== 14
]

Decision: 1
Statistic Training
1: 7%

o: S93%

N in node: Z895
Profit: 0,55

7 Select View » Tree Map from the main menu. The node that has only 46
observations is shaded red in the Tree Map. Recall that the width of the node is
proportional to the number of training cases in the node. Nodes that contain few
observations cannot be drawn accurately in the space that is allocated to the view.
Depending on how your windows are arranged, you might or might not see a red
node. Try reducing the size of the Tree Map window in order to see a node that
has fewer observations.
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& EMWS Tree2 BROWSETREE[EMWS REPLACE_TREE
T File Edit Model Train “iew Options Window Help 5] x|

Statistic Training
I% 1: 103 ,_i
o: 0%
H in node: 46 | Train Interactively |Priar 2

Prune a Node from the Tree
Use interactive mode to prune a tree.
1 To define a split for any current terminal node, right-click the node. Select split

Node, then select a splitting rule, and click [OK]. This example uses the top right
node, the node that has 2,989 observations.

PEP STAR
u] 1
]

Decision: 1 Decision: 1
Statistic Training Statistic Training
1: 3% 1: E%
0: 97% 0: SE%
N in node: 4541 N in node: z29839
Profirc: .oz Profirt: o_z5

LIFETIME GIFT_COUNT
|

[ |
= .5 = .5
N
1 Decision: 1
Training Statistic Training
1: E%
0: QL%
N in node: Z98E
Profit: 0.zd4

2 Right-click the parent node for the split that you just defined and select Prune.
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PEP_STAR
u] 1
|
Deciszion: 1 Decision: 1
Statistic Training Statistic Training
1: 3% 1: B
0: 97% 0: 95%
N in node: 4541 N in node: 983
Profit: ooz Drofit: 0.zE
Split Mode...
— Trai )
Il
12 . Trainlnterakﬁ'el}l m: 1
= Yiew Fesults. . e Training
1: 1: E%
o: 0: QL%
= N in node: 298K
it : Profit: 024
Note: You can also define splits and prune nodes from the Tree Map view.

% Tree Map - EMWS TreeZ_BROWSETREE

|
Split Node... I

Train

® Train Inter;EEtively
Yiew Results...

Train the Tree in Automatic Mode

At this point you can continue to split and prune nodes interactively until you obtain
a satisfactory tree, or you can use the algorithm to train the rest of the tree in
automatic mode.

1 To train the tree in automatic mode, right-click a terminal node that has several
observations, then select Train. Repeat the process as desired for other nodes.

Decision: 1
Statistic Training

Split Naode...
ie 7%
0: S93%

Erume k
N in node: 2895

Profit: 0.55 & Tran Interactively

Wiew Results. .
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Other Tree Control Features

Here are some additional Tree features that you might want to explore:

0 Use the zoom in/out feature by right-clicking on the background of the Tree and
selecting Zoom. You might also want to change the node statistics.

0 Follow a similar menu path to change the font.
o To print the tree on one page or across multiple pages, select File » Print.

View the Tree Results

At this point you are still working in interactive mode.

1 From the main menu, select Train » View Results to change to the results
viewer mode. In this task you incorporate validation data into the evaluation of
the tree.

File Edit M-:u:leI|Trair| Yiew Ophtions 3
Split Hode. .

Train
Frune

® Trait [nkeractively

Yiew Results...

2 From the main menu, select
View p Leaf Statistics Bar Chart
and
View » Leaf Statistics Table
to open the Leaf Statistics Bar Chart and Table.
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Yiew Options ‘Window Help

® Vanable Labelz
W anahle Mames

Azzezsment Plot
Azzezzment Table
Clazzification b atrix

v Tree Chrl+T
v Tree Map Clrl+kd
Local Tree Chrl+FR
v Leaf Statistic Bar Chart
Wariable “wfidth Bar Chart

Wariables

Fath Rule

Leaf Paths

Competing Rules
Competing Rules Details
Surmogate Rulez
Surmogate Rules Detailz

The Leaf Statistics Bar Chart and Leaf Statistics Table windows open.

& EMWS Tree?2_ BROWSE TREE[EMWS. REPLACE_TRAIN] - SAS Enterprise Miner Tree __. [H[=] E3
File Edit HModel Train Wiew Options ‘Window Help
_|olx]
; =
Hode H Cases el
Ca
1 + 10 3.6663 14
2 §2.5016 Decision: dl
3 g 46,4018 Sratistic Training Validation
4 3 2594 56 ilg 7% 74
5 1 298548 e EEQ B0
5 5 440 TE N in node: 2895 Z410
- Profit: 0.EL 0.5z
o | » v 4
‘ =10l x| =[Ol
Percentage of target value 1 in data
704
E
a4
]
=]
o
104
o= 0 T H B 1 5
Leavscin order ofpsroentage oftarget value 1
e Tiee Map - EIV‘ i3 Tree- EMWS.”E Leaf Statistics il Leaf Statisticd
For Help, press F1 Wiew Resultz |Priorz Applied v

3 Right-click inside the Leaf Statistics Bar Chart and select Bar Chart Properties.
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11 Leaf Statistic Bar Chart - EMwS___ [lj[=] E3

Percentage of target value 1 in data

0 Bar Chart Froperties...

a Undo Zoom k
@ Export az image...

0

ki

i |

: h

. Il e

10 T 2 ] 11 =
Leauecin order ofperoentage offrget vaiue 1

4 Examine the various Bar Chart settings.

Leafl Statiztic Bar Chart Properties EE3 |

Bars | Bar Colors I
— Bar height

Event: |1 j

&% Event percentage [gain)

€ Cumulative gain
" Curnulative lift
" Percentage comectly predicted
" M cases in leaf

" Average profit

—Bars
™ Training W alidation = Both

(] Cancel Sl

5 Select a node, a subtree, or a variable in one window. Note that the other windows
are automatically updated to select the corresponding items.
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& EMWS Tree?2_ BROWSE TREE[EMWS. REPLACE_TRAIN] - SAS Enterprise Miner Tree __. [H[=] E3

File Edit HModel Train Wiew Options ‘Window Help

) [ o ] 3
i =EE] zazz ;l
Valicl
Hode H Cases zE 0.24
Ca
1 + 10 36663 FT_COUNT
3 g 46,4015 = Z.E5
4
3 2334 85 Decision: 1
Statistic Training Validation
5] 5 464078 alg 5% 5%
o: a5% 95%
N in node: z9aL Z419
Profit: 0.24 o.23
-
a| | 7

-|EI|5| = Tree Map - EMWS . Tree? BRO... M=l E3

10 7 B B 1 5
Lsauncin order ofperoeniage ofBrget vaiue 1

[ TreoMeap-EV g3, Tiee - EMWS. | FF] Leat Statstics | Il Leaf Statistc &
For Help, press F1 [iew Results [Prios dpplied | | | 2

6 From the main menu, select View » Assessment Plot to display the Assessment
plot.

Note: You can select a smaller tree interactively by selecting a smaller number
of leaves in this plot. This feature allows you to choose a smaller tree that
performs well using both the training and validation data. A

View the Tree in the Java Tree Results Viewer of Enterprise Miner

1 Close the application and save the changes to the model. The following message is
displayed when you close the model in the Tree Desktop Application.

Update Enterprise Miner
Start updating E nterprize Miner,

pleaze do not run the diagram until the dezktop
= application has successfully closed.

2 Run the Decision Tree node path from the Diagram Workspace and follow the
messages that direct you to view the results.
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&l Results - Decision Tree (2] [_TO] %]
File Edit View ‘Window
gl Bl 2l E 4]
Score Rankings Overlay: TARGET_B |9 [=] E3 —|ol x|
Select Chart 015
; 040
=20
Eis 005
S0
T T T T T T
0 20 40 60 80 100
Decile L 2 3 4 8 10 12 14
——TRAIN __— VALIDATE Ceaijlndex
0% B%YV1
5 ioixd
TARGET | Fit statistics |StetisticsLa | Tran | valk
[TARGET_B _MNOBS_ Surn of Frequ... 10654 =
TARGET B _SUMW_  Sumof Case 21308
TARGET B _MISC_ Misclassificat...  0.250047 0
TARGET B | MaX_ Maximum Ab... 0813998 0f
TARGET B | SSE_ Surm of Saua. . w7618 3
[TARGET_B _MASE, Average Sgu 0.181698 o
TARGET B _RASE Rodt Averag... 042626 0.
TARGET E DIV Divisor for ASE 21308
TARGET B DFT Total Decree... 10654 hd
1 5
Eii Output =0l x|
! E
2
3
4
5 Variable Summary
5
7 ROLE LEVEL COUNT
]
FREQUEMNCY_STATUS_G7MIK = 9 INPUT BINART 4 =
n am warnren A -~
Kl L _'I_I R _'I_I

Close the Tree Results window.

Rename the second Decision Tree in your diagram to indicate that it was the
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interactive training tree. Right-click the second Decision Tree node, select Rename,
and rename the node, Interactive Decision Tree

Decigion Tree (2)
O O Edit Variables. .

Y Update
Z Run

=P Results...

@ Create Model Package. ..
@ Ewport Path az 545 Program

Cut
Copy

Delete

Select All l !

Select Modes

Connect Modes
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|

Mode Mame:

IInterau:tive Decizion Tree

Ok Cancel

5 Click .

,_H_uﬂ.

DOROR_R&AN S StatExplore hultiF ot gg}
@

DATA
=25 . :TI’:‘I Decision Trea
Data Partition Replacement g::he

Interactive
Decision Tree
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Overview of This Group of Tasks

These tasks show you several ways to fill in missing values across observations. You
also create new variables from existing variables and reduce the number of input
variables.

About Missing Values

Many of the input variables in the Donor data set that you have been using have
missing values. If an observation contains a missing value, then by default that
observation is not used for modeling by nodes such as Variable Selection, Neural
Network, or Regression.

Depending on the type of predictive model that you build, missing values can cause
problems. If your model is based on a decision tree, missing values cause no problems
because decision trees handle missing values directly.

However, in Enterprise Miner, regression and neural network models ignore
observations that contain missing values. Substantially reducing the size of the training
data set can weaken these predictive models. It is wise to impute missing values before
you fit a regression model or neural network model. When you replace missing
observations with imputed data, regression and neural algorithms are able to perform
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whole-case analysis on the entire training data set. If you do not impute missing values
for these models, the missing values might result in the creation of an inferior model.
Additionally, it is important to impute missing values if you are planning to compare a
regression model or neural network model with a decision tree model, because it is
more appropriate to compare models that are built on the same set of observations.

Impute Missing Values

In this task, you use the Impute node to replace the missing values in the Donor
data set.

1 Drag an Impute node from the Modify tab of the toolbar into the Diagram
Workspace, and connect it to the Replacement node.

[Fm |
EE‘:l -ﬂ' lmpute
DOMOR_RAY Y StatExplore PuitiP ot

DATA
Decision Tree

30

Interactive
Cecizion Tree

Data Parition Replacement

2 Select the Impute node in the Diagram Workspace. The Impute node property
settings are displayed in the Properties panel.

For class variables, the Default Input Method property uses Count. The Count
method replaces missing values with the value that is most common among all
observations. The Mean method replaces missing values with the average of all
the non-missing values. By default, Enterprise Miner does not impute
replacement values for target variables.

3 Set the following properties in the Impute node Properties panel:

0 In the class Vvariables section, set the Default Input Method property to
Tree Surrogate.

O In the Interval Variables section, set the Default Input Method
property to Median.

Property “Yalue I
Mode D Irnpt -
Imparted Data
Exported Data
ariahles

Tree Surrogate H

Maone

?'Default Input Method
Default Target Method Mone
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4 Right-click the Impute node and select Run. When the run is complete, click
in the Run Status window. You do not need to view the Results window now. The
Impute node must run before you can use some of the features in the Transform
Variables node.

Create Variable Transformations

Overview

Some data can be better mined by modifying the variable values with some
transformation function. The data is often useful in its original form, but transforming
the data might help maximize the information content that you can retrieve.
Transformations are useful when you want to improve the fit of a model to the data.
For example, transformations can be used to stabilize variance, remove nonlinearity,
improve additivity, and correct non-normality.

You can use the Formula Builder and Expression Builder windows in the Transform
Variable node to create variable transformations. You can also view distribution plots of
variables before and after the transformation to assess how effective the data
transformation is.

View Variable Distribution Plots
1 Drag a Transform Variables node from the Modify tab of the node toolbar into the
Diagram Workspace.
2 Connect the Impute node to the Transform Variables node.

‘ % . ﬂ_]l!—l'tt

Impute Transfarm
DOMOR_RMAY Y StatExplore hultiP 1ot

Yariables
DATA };';if

Decision Tree

30

Interactive
Decigion Tree

3 Select the Transform Variables node in the Diagram Workspace to view its settings
in the Properties panel. The default transformation method for all variables is
None. You can use the Variables property to configure variable transformation on
a case-by-case basis, or you can use the Default Methods section of the Properties
panel to set transformation methods according to variable type.

The variable distribution plots that you view in the Transform Variables node
are generated using sampled data. You can configure how the data is sampled in
the Sample Properties section of the Transform Variables node Properties panel.
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4 In the Properties panel for the Transform Variables node, click the ellipsis button
to the right of the Formula Builder property. This action opens the Formula
Builder window.

Property | Walue
FHode 1D Trans
Imported Data
Exported Data

ariables
Formula Builder
Interactions Editor

In the Formula Builder window, the New Variables table is empty, because you
have not created any variables yet.

MAME TYPE LENGTH FORMAT LEWEL FORMULA, LABEL ROLE
<
| | i
Hew Variables |;5' | Origingl Variakles |;5' | Sample Properties E§' | Sample |;5' | Log |;5' |
GEnerate Flot | OK | Cancel |

5 Select the original Variables tab to see a list of the current variables and a
distribution plot for the selected variable.

6 Examine the distributions of the current variables, and note which variables
might benefit from transformation. A good variable transformation modifies the
distribution of the variable so that it more closely resembles a normal distribution
(a bell-shaped curve).

7 View the distribution plots for the variables SES and URBANICITY to see the
data before the missing values were replaced with imputed values. Distribution
plots for the variables IMP_REPL_SES and IMP_REPL_URBANICITY show the
data after the missing values were imputed and replaced.
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Formula Builder [ %]
600

Frequency
=
=]
=]

(=]
o
[=]

C R & T u
Imputed: Replace:URBANICITY
I Mame Methoc Mumber of Bins Raole Level
IMP_DOROR_AGE Cefault 4|Input Interval ;I
IMP_IMNCOME_GROUP Default 4{lnput Interval _
IMP_MOMNTHS_SINCE_LAST FROM_RESP |Default 4llnput Interval
IMP_REPL_SES Default 4Input Mominal
IMP_WEALTH_RATING Default 4{lnput Interval
IM_HOUSE Default | 4lnput [Einary _,LI
T i A Tmogre oo 1 PPy [P
T »

New variables [ Original Variables [ | Sampie Properties [ | Sample [ | Log [ |

GEnerate Flot | Cancel |

Add a Variable Transformation

1 Select the New Variables tab to create a new variable by using the Formula
Builder.

e
2 Select the Transform Variables icon on the left side of the Formula Builder
to start creating a variable transformation.

Formula Builder [ %]

TYPE LENGTH FORMAT LEWEL FORMULA LABEL ROLE

| | i

| Hew Variables [ | Originl Varisbles [ | Sample Properties [ | Sample [ | Log [ |

GEnerate Flot | Cancel |
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The Add Transformation window opens.

Add Transformation | x| |

Propetty | Walue I
Mame TRAMS O
Type [+
Length g
Farmat
Level Interval
Lahel
Fale Input
Feport [ [}
Farrmula:
TRAMS 0=
Build. .. ] 04 Cancel

3 Edit the following value columns to configure the new variable that you are
creating:

0 Change the Name from TRANS_O to OVERALL_RESP_RATE.
O Set Format to PERCENT6..

O Set Label to Overall Response Rate.

Property I Yalue I
Marne OWERALL_RESF_RATE
Type i
Length A
Farmat FERCEMTE.
Level Interval
Lahel Cverall Response Rate|
Rale Input
Report i [
Farmula:
OWERALL_RESP_RATE =

Biild.... '\J OK I Cancel
by

4 Click in the Add Transformation window. The Expression Builder window
opens.
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Exprezzion Builder (%]

Expression Text:

+

-|*|.l’|**| ANDlORlNOTl =|"=

2 | ==

Functions I Wariables Listl

Cateyories Functions:
ARCOS(argumert) =
Avrithmetic ARSIMCErgurent]
Character AT AN arguUment)
Descriptive Statistics CEIL(argument)
Matherrstical COS(argument]
Probahbility and Density COSH argument)
Rand?m Mumber DR AN(seed)
?Pemal et o i EXPlargument)
rlgonom tic and Hyperbolic FLOOREargument)
Truncation
IMDEX(source gxcerpt) ;l
| Functions &l

0K I Cancel |

5 Note the comprehensive list of pre-built SAS functions that are available for
variable transformations.
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6 Select the variables List tab in the Expression Builder window. Scroll down the

list of variables to LIFETIME_GIFT_COUNT, select it, and click [Insert]. The
LIFETIME_GIFT_COUNT variable appears in the Expression Text box.

Expression Builder

Expression Text:

1 1 Y O S S I o sy
Functions Vatiables Listl
List of Mew and Criginal “ariable Mames:

Mame Ruole Lewel Type I
LIFETIME_CARD_PROM Input Interval 1N =
LIFETIME_GIFT_AMCUMT Input Interval il
LIFETIME_GIFT_COUMNT Input Interval il
LIFETIME_GIFT_RANGE Input Interval 1]
LIFETIME_MAX_GIFT_AMT Input Interval il
LIFETIME_MIM_GIFT_AMT Input Interval il
LIFETIME_FROM Input Interval il
MEDIAN_HOME_VALLIE Input Interval N Ll

T — i
|ﬂ >| Insert [g‘
[Insert a selected variable name into ewression testvisld |

Ok I Cancel |

7 Click the division operator button / . Return to the variables List tab and

select the variable LIFETIME_PROM.
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E xprezsion Builder

Expression Text:

LIFETIME_GIFT_COUMT £

8 Y Y I I 3 Y O
Functions Yariables Listl
List of Newy and Original Yariable Mames:

Mame Fale Lewel | Type
LIFETIME_CARD_PROM Input Interval il ;I
LIFETIME_GIFT_AMOUNT Input Interval i)
LIFETIME_GIFT_COUNT Input Interval i)
LIFETIME_GIFT_RAMGE Input Interval i) J
LIFETIME_tlak_5IFT_AMT Input Interval il
LIFETIME_MIM_GIFT_AWT Input Interval &}
LIFETIME_FROM Input Interval I+l
MEDIAN_HOME_WALLUE Input Interval k] Ll

1 2
LIFETIME_FPRO ﬂl}l

[Inzert a selected variable name into ewression teut field |

| O I Cancel |

8 Click [Insert]. The LIFETIME_GIFT_COUNT/LIFETIME_PROM expression
appears in the Expression Text box.

Expression Builder

Expression Text:

LIFETIME_GIFT_COURT J’LIFETIME_PROM'

I T Y O Y ) Y s
Functions Watiables Li31|
List of Mew and Original Yariable Mames:

Marne Role Level Type
LIFETIME_GIFT_AMCUMNT Input Interval I ;I
LIFETIME_GIFT_COUNT Input Interval I
LIFETIME_GIFT_RANGE Input Interval I
LIFETIME _hA%_ GIFT_AMT Input Interval I
LIFETIME_MIMN_GIFT AT Input Interval I+
LIFETIME_FROM Input Interval I
MEDIAMN_HOME_WALUE Input Interval I+
MEDIAN HOUSEHOLD INCOME Input Interval I _lll

1| | 3
LIFETIME _PROM Inzert |

Ok I Cancel |

9 Click in the Add Transformation window.
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Add Transformation | x| |

Propetty | Walue I
MHame OWERALL _RESF_RATE
Type [+
Length g
Farmat FERCEMTE.
Level Interval
Label Cwerall Response Rate
Fale Input
Feport [ [}

Formula:
OWERALL _RESP_RATE =

LIFETIME _GIFT _COUMT # LIFETIME _PRCibA

Buildd... 0] 4 Cancel

10 In the Formula Builder window, click to see a plot of the new
variable.

Formula Builder [ %]

Preview plot for the selected variahle "OVERALL_RESP_RATE".

LENGTH FORMAT FORMULA,
PERCEMTE. Interal

4 | i

| Hew Variables [ | Originl Varisbles [ | Sample Properties [ | Sample [ | Log [ |

Generate Plot ! Cancel |

11 Note that because the distribution of OVERALL_RESP_RATE is skewed, you
should return to the Formula Builder window to transform it further.
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Formula Builder [ %]

600

=

o

[=]
1

Frequency

200+

3% 10% 18% 25% 33% 40%
Overall Response Rate

T T T T 1
48% 66% G3% T0% T8%

LENGTH FORMAT

TYPE

1

LEWEL FORMULA, LABEL ROLE
PERCEMTE. Irtersyal

LIFETIME_GI.

| 2

| Hew Variables [ | Originl Varisbles [ | Sample Properties [ | Sample [ | Log [ |

GEnerate Flot |

Okt | Cancel |

12 Click the Edit Expression button S on the left side of the Formula Builder.
13 Select the LIFETIME_GIFT _COUNT/LIFETIME_PROM expression in the

Expression Text box.

14 On the Functions tab, select the Mathematical folder and then select
LOG (argument) from the panel on the right.

Expression Builder [ %]

Expression Text:

+

—|*|.l'|**| ANDlORlNOTl =|"=

Functions I Variables Lis‘tl

Categories: Functions:
All Functions E P argurnerit)
Arithimetic LOGiargument)
Character L0 Ofargumert)

Descriptive Statistics

Probability and Density
Randarm Murnber

Special

Trigonometric: and Hyperbolic
Truncation

LG =num'alues=]

Inzert

The LOG function returns the natural (hase &) logarithm.

[Insest fumction from Function list]

(9038 I Cancel |

15 Click [Insert]. The expression text is updated as follows:
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Expression Builder

Expressian Text:

LG LIFETIME_GIFT_COUNT / LIFETIME_PROM)|

16 Click in the Expression Builder window.
17 Click [Refresh Plot| at the bottom left of the Formula Builder window.

Formula Builder E2

400+

300+

Frequency
e
(=}
=
Il

1004

04
(364%) (330%) (206%) (262%) (228%) (104%) (161%) (127%) (03%) (509%)
Overall Response Rate

LENGTH FORMAT

PERCEMTE

FORMULA
LOG( LIFETI

Irteryval Owerall Resp. . |Input

« | |

[——— [ | Original Variables | Sample Properties [ | Sample [ | Log [ |

GEnerate Blot Ok | Cancel |

The distribution is now much closer to a normal distribution.

18 Because the Overall Response Rate variable has been mathematically
transformed, the variable’s format (PERCENT) is no longer accurate. The variable
format requires updating. To change the variable format, click the Edit Properties

icon B2 on the left side of the Formula Builder.
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19 In the Edit Transformation window, select Format and then press the Backspace
key to clear the text box. Leave the Format value blank in order to use the default
format for numeric values.

Edit Transformation | x| |

Propetty | Walue I

MHame OWERALL _RESF_RATE
Type [+
Length
Farmat
Level Interval
Label Cwerall Response Rate
Fale Input
Feport [ [}

Formula:

O%ERALL_RESP_RATE =

LG LIFETIME _GIFT _COURT § LIFETIME_PRON)

Buildd... | 0] 4 él Cancel

20 Click in the Edit Transformation window.
21 Click to exit the Formula Builder.

Apply Standard Variable Transformations

You can now apply standard transformations to some of the original variables to
modify the distributions so that they more closely resemble a normal distribution.
Typical transformations include functions such as logarithmic functions, binning,
square root, and inverse functions. The default method for variable transformations for
all target and input measurement levels is none, as noted in the Properties panel.

1 To apply transformations to selected variables, click the ellipsis button to the right
of the variables property in the Transform Variables Properties panel.

Propetty Walue

Mode D Trans
mported Data
Exported Data
ariables
Farmula Builder
Interactions Editor

The Variables - Trans window opens.
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2 You can transform individual variables in the Variables - Trans window. Apply the
Log Method transformation to each of the following variables:

FILE_AVG_GIFT
o LAST GIFT_AMT
o LIFETIME_AVG_GIFT _AMT
o LIFETIME_GIFT _AMOUNT

O

You can highlight adjacent variable rows, or you can hold down the CTRL-key and
selecting non-contiguous variables and apply the same transformation to these
highlighted variables.

Variables - Trans
IMame Method Mumber of Bins | Raole
OONOR_GERDER BTaul FTApLT ;l
FILE_AVG_GIFT Log 4 Input
FILE_CARD_GIFT Default 4/ Input
FREGUENCY STATUS 87Nk Default 4|Input
HOME_OWWHNER Default 4 Input
IMP_DONOR_AGE Default 4/Input
|IMP INCOME_GROUP Default 4/Input
|IMP MOMNTHS_SIMCE_LAST_FROM_RESF Default 4/ Input
|IMP REFL_SES Default 4/Input
|IMP REFPL_URBANICITY Default 4/Input
|IMP WEALTH_RATIMG Default 4|Input
lIN_HOUSE Defautt 4lnput
LAST GIFT_AMT Log 4 Input
LIFETIME_&WG_GIFT_AMT Log 4 Input
LIFETIME_CARD_PROM Default 4/Input
LIFETIME_GIFT_AMOUMNT Log s 4/Input
LIFETIME_GIFT_COUNT Drefaitt - 4/Input
LIFETIME_GIFT_RANGE Mone 4/Input
LIFETIME MAX GIFT AMT Croup Rare L 4|Input _lLI
Couarrirrry Inclicsk=— d
Souare gﬂt Ok I Cancel | Help |
“|rverse
Sojuare -

3 Apply the Optimal method to the following variables:
o LIFTIME_CARD_PROM

LIFETIME_GIFT_COUNT

MEDIAN_HOME_VALUE

MEDIAN_HOUSEHOLD_INCOME

PER_CAPITA_INCOME

RECENT RESPONSE_PROP

o RECENT_STAR_STATUS

Note that you can hold down the CTRL key and select multiple variables to
change their settings at one time instead of changing each one individually.

O o o o g
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Mame | hethod I Mumber of Bins |
MEDIAN_HOUSEHOLD_IMCOME Default 4;|
MOMNTHS_SINCE_FIRST_GIFT Default 1
MOMTHS_SINCE_LAST GIFT Default 1
MONTHS_SINCGE_ORIGIMN Default 4
MOR_HIT_RATE Default 1
NMUMBER_PROM_12 Default 4
OVERLAY _SOURCE Default 1
PCT_ATTRIBUTE! Default 1
PCT_ATTRIBUTEZ Default 4
PCT_ATTRIBUTES Default 1
PCT_ATTRIELUTE4 Default 4
FCT_OWHER_OCCURIED Default 1
FEP_STAR Default 1
FER_CAPITA_INCOME Default 4
FLBLISHED PHOME Default 1
RECERCY STATUS 96MK Default 4
RECENT_AVG_CARD_GIFT_AMT Default 1
RECENT _AVG_GIFT_AMT Default 1
RECENT _CARD_RESPOMSE_COUNT Default 4
RECENT_CARD_RESPOMSE_FROP Optimal 1
RECENT _RESPOMNSE_COUNT Default 4
RECEMNT_RESFOMSE_FROF Default 1
RECENT_STAR_STATLIS Optimal b i JI.
SES Standardize | = 1
TARGFT R EiLicket 4L|

Guartile —'I
Explaore... Max.Normalk Cancel | Help |
T |max. Correlsti
Ecjualize |
Optitrial Max, E -

4 Select the Method column heading to sort the variable rows by the transformation
method.

5 Click to close the Variables - Trans window.
Note: When Enterprise Miner creates imputed variable values in a data set,
the original data set variables remain, but are automatically assigned a Rejected

variable status. Rejected variables are not included in data mining algorithms
that follow the data imputation step. A

6 Run the Transform Variables node.

Develop a Stepwise Logistic Regression

Overview

SAS Enterprise Miner provides numerous predictive modeling tools. The Regression
node automatically performs either a logistic or ordinary least squares regression,
depending on the target measurement level. Like the Decision Tree and Neural Network
nodes, the Regression node supports binary, nominal, ordinal, and continuous targets.
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This task builds a regression model that uses the partitioned, imputed and
transformed DONOR_RAW_DATA data set.

1 Drag a Regression node from the Model tab of the toolbar into the Diagram
Workspace, and connect it to the Transform Variables node.

H%e -ﬁ]H@HIL“

e StatExplore  MultiPlot Impute  Transform Regression

DOMOR_RA Varighles
e
:::.._..E\E.

DATA
Decision Tree
[Diata Pattition Replacement

£3o

Interactive
Decizion Tree
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Create Histograms of Transformed Variables

It might be useful to view the distributions of newly transformed variables before you

set the properties in the Regression node Properties panel.

1 Select the Regression node in the Diagram Workspace to view the node settings in

the Properties panel.

2 Click the ellipsis button to the right of the variables property to open the
Variables - Reg window.

The transformed variables that you created begin with variable prefixes LOG_

and OPT_. The imputed variables that you created begin with an IMP_ prefix.

Note: If you do not see these variables, close the Variables - Reg window,
right-click the Regression node and select update. A
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Yanables - Reqg

Marne

IM_HOLUISE
LIFETIME_GIFT_RAMNGE
LIFETIME_hAK_GIFT_AMT
LIFETIME_MIM_GIFT AT
LIFETIME _FRCh

MONTHS_SINCE FIRST GIFT
IMONTHS_SINCE_LAST GIFT
IMONTHS_SINCE_ORIGIN
IMOR_HIT RATE

NUMBER _PROM 12

3 Select the TARGET_B variable, as well as variables that have the prefixes IMP_,
LOG_, and OPT in order to create a histogram or bar chart of all the transformed
variables.
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Variablez - Reg
Marne | Lise | Report

QOFT_LIFETIME_CARD_FPROM Default Mo :I

COPT_LIFETIME_GIFT_COUMNT Default Mo

QOFT_MEDIAM_HOME_WALUE Default Mo

QOFPT_MEDIARN HOUSEHOLD IMCOME Default Mo

OFT _FER_CAPITA INCOME Default Mo

QOFT_RECEMT_RESFPOMSE _FROF Default Mo

QOFT _RECEMT _STAR_STATUS Default Mo

OWERLAY SOURCE Default Mo

FCT ATTRIBUTE1 Default Mo

FCT ATTRIBUTEZ2 Default Mo

FCT ATTRIBUTEZ Default Mo

FCT ATTRIBUTE4 Default Mo

FCT OWHMNER OCCUPIED Default Mo

FEF _STAR Default Mo

FLEBLISHED PHOME Default Mo

RECEMCY STATLIS S6EMK Default Mo

RECEMNT AWG CARD GIFT AMT Default Mo

RECEMNT AWG GIFT _AMT Default Mo

RECENT CARD RESFORSE COURNT Default Mo

RECENT CARD RESFOMSE PROP Default Mo

RECENT RESPOMSE COLUMNT Default Mo

SES Default No

TARGET B Yes Mo

TARGET D Default Mo —

LIRRARICITY mlh‘ has _Ij

1 »

Explare... Qj Ok I Cancel | Help |

4 Click [Explore].

5 Maximize the Explore window. Then from the menu, select Window » Tile in
order to improve the visual layout of the plots.
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.~ Explore - EMWS_Trans_TRAIN
File “iew Actions ‘Window

= E3

T AMPSRERR] =

LOG_LIF S m]JES|

i

OPT_WME ] [ES|

[ .

LOG_LIF - S]]

il

OPT_PE._ J [l [ES|

T (ol

il

IMP_WE [ Jm] JES|

_l

OPT_LIF. . S ][ |

i __

OPT_RE . JS [l [ES|

-

IhP_INE. [ [ [ER]

ol

LOG_FIL. | [E|

ol

OPT_LIF.. ][R

OPT_RE... [ [[a][ES|

..

[ T UNESHER =Tk

s

W00 ol

b

OPT_WE... [ ][R

TARGET_B I [ i3

e

6 The plots for each variable are created using a sample size of 2,000 observations.
In the Sample Properties window, set the Fetch Size to Max and then click
to plot all 10,654 observations on the client.

7 Select each level of the target variable in order to view how the donors and
non-donors are distributed across each of the transformed variables.



Working with Nodes That Modify, Model, and Explore /A Set Regression Properties 103

.~ Explore - EMWS Trans_TRAIN [_ [0l x]
File Edit “iew Action:z ‘Window

& H|O|@"|
B ol [ Cos-UEERMMT=IE] | * oriwEDI 1=

Property
B Data
Sample MettTop 7
7

7
EZ‘EESEZEF T g_ !ﬁZz_ T —

Fetched Rowl 0654
1MP_REPL. M [=[FH|| . L0G_LIFET M [=]ES|| . oPT_PER_ &M jim[ES|
Anpby | Plot... |

85 EMWS. Trae 8 =] [ES|

!///// N t% = ./

[y

o T | R T i
e R

I . - b
‘L __zmi /j EE z_rllﬂ_%
iz zazeg) [ o ERI=TE] [ _orT rERMTEY] [ ort RECRTE

T 1Al ..
= I; =z || W%%%_ W%V/J

(TP V=TE Y | T OGRS T="EY _|_|_| ;l_n_l

»

NN

7Y s

Note that some of the heavily skewed variables are more normally distributed
after you apply the logarithmic transformation.

8 Close the Explore window and then close the Variables window.

Set Regression Properties

The Regression node can select a model from a set of candidate terms by using one of
several methods and criteria. In this task, you specify a model selection criterion that
you use during training.

1 Select the Regression node in the Diagram Workspace. In the Regression node
Properties panel, set the Regression node Selection Model property to Stepwise.
This setting systematically adds and deletes variables from the model, based on the
Entry Significance Level and Stay Significance Levels (defaults of 0.05).

2 Run the Regression node and then view the results. Examine the average profit of
the validation data

By default the Regression node displays the following:

O A table of fit statistics for both the training and validation data. Examine the
average profit in the validation data.

O A cumulative lift plot (score rankings) across the various deciles for the
training and validation data sources. The plot lift values are very consistent
for both the training and validation data. You can change the plotting
variables on this chart as you did when viewing the lift plot for the decision
tree. You can change the vertical axis (Y) to display profit.
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O An effects plot that shows the model effects in order by size. The model effects
are sized according to their absolute coefficients. The color of the model effect
indicates the sign of the coefficient. When you hold your mouse pointer over
the effect bars, you will see that some of the transformed inputs and one of
the imputed variables have significant effects in the stepwise selection.

O A detailed output window. The detailed output window provides several
statistics in addition to a summary of the stepwise selection process.

3 Close the Results window.

Preliminary Variable Selection

The Variable Selection node can help you reduce the number of inputs to your models
by rejecting the input variables that are not related to the target. The remaining inputs
can then be modeled by using a more intensive algorithm such as a neural network.

1 Drag a Variable Selection node from the Explore tab of the node toolbar into the

Diagram Workspace, and connect it to the Transform Variables node.

H % e -ﬁ)h""@ IL ®

o StatExplore MultiPlot Impute  Trapsform | Regression

DOMOR_RA Variahles
DATA @ e
I v 7
____._..E\E, ecision Tree
Data F'arfitinn Replacement

Variable Selection
é 20

Interactive
Decision Tree

2 Select the Variable Selection node in the Diagram Workspace and set the following
Variable Selection properties in the Properties panel:

O Set the Target Model property to Chi-Square.
O Set the Hide Rejected Variables property to No.

Property Walue
Mode (D arse|

Imported Data
Exported Data

ariables
Max Class Level 100
Max Missing Percentage|al
Tarnet Model Chi-Souare H

Hide Rejected Yariables|ho
Feject Lnused Wariablesyes

3 Run the Variable Selection node and view the Results window.

The Variable Selection table provides a list of the selected variables. The
Results window also displays a histogram that is called Variable Importance. The
histogram shows each variable’s contribution toward a prediction, based on
Chi-squared scores. Hold your mouse pointer over a bar in the Relative
Importance plot to view its variable name and relative importance score.
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&Y Results - Variable Selection M= E3
File Edit ‘iew ‘wWindow

53] =1 S N

S=
1.0 7= Mame Role Level Type
CARD_PROM... Input Interval M
8 084 CLUSTER_C... Rejected Morminal c
= DONOR_GEN... Rejected Morninal C
E FILE_CARD_... Input Irterval ]
2064 FREGLENCY ... Input Mominal M
E HOME _CWWHER Rejected Binary c
g A MP_DOMOR_ . Input Irterwal M
'g . MP_INCOME... Rejected Irterval ]
o MP_MONTHS . Rejected Irterval M
= 024 MP_REPL_SES Rejected Morminal c
MP_REPL_U... Input Morninal C
e HHW MP_WYWEALTH. . Input Irterval ]
: Variable <IH o S - b |
=loix|
1
)
3
4
5 Variable Summary
&
7 FROLE LEVEL COUNT
g
9 INPUT BINARY 4
10 INPUT INTERVAL 30
11 INPUT NOMINAL 13
12 EREJECTED INTERVAL 1
13 EREJECTED NOMINAL 3
4

4 Close the Results window.

Develop Other Competitor Models

Overview

Enterprise Miner enables you to try several different models and then compare the
results in one common framework. You can then choose the best model for scoring new
data.

One method of arriving at a model is the artificial neural network. The artificial
neural network attempts to mimic the actions of the human brain, which is a large
organic neural network. Experienced data miners know that artificial neural networks,
when carefully tuned, are often very useful in showing nonlinear associations between
inputs and the target. Common applications for neural network models include credit
risk assessment, direct marketing, and sales predictions.
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Add a Neural Network

In this task, you use the Neural Network node to build a neural network model that

is based on your data.

1 Drag a Neural Network node from the Model tab of the node toolbar into the
Diagram Workspace, and connect it to the Transform Variables node.

H._Eﬂ.

StatExplore  MultiFlot Irripute

3o

Cecision Tree

3o

Interactive
Decision Tree

i

DOMOR_RA
DATA,

Y

I/_-.

Transform
Yariahles

Egressinn
e

ariable Selection

>odieo

Meural Metwork

2 Select the Neural Network node in the Diagram Workspace, then set the following
Neural Network properties in the Properties panel:

O Set the Direct Connection property to Yes.

0O Set the Number of Hidden Units property to 5.

0 In the Preliminary Training Options section, set the Preliminary

Training property to Yes.

Property “alue

Mode D Meural
Imported Data
Exported Data

ariahles
Llse Current Estimates ko
Architecture mLF
Direct Connection B5
Model Selection CriterionProfitlLoss
Mumber of Hidden Lnits

Training Of

2] ary Training Op
‘Preliminary Training i
aximurm lterations

3 Run the Neural Network node.
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Add an AutoNeural Model

The AutoNeural node enables you to find optimal configurations for a neural network

model.

1 Drag an AutoNeural node from the Model tab of the node toolbar into the Diagram
Workspace, and connect it to the Variable Selection node. The combinatorial
search that the AutoNeural node performs can be computationally expensive, so
you should reduce the input set for training.

! _ﬂ.)'—u-e \4 °

Impute  Transform | Regression
Wariables

Decé?r?:ree H §§3 e

righle Selection AutoMeural
Ak
Interactive ?”'

Decision Tree Meural Metwork

[Fm] [
o>olgle
e StatExplore MultiPlat

DOMNOR_RA!
DATA

Data Padition Replacement

2 Select the AutoNeural node in the Diagram Workspace, and then set the following
properties in the AutoNeural Properties panel:
O Set the Architecture property to Cascade, in order to add nodes in a
cascade fashion.
O Set the Train Action property to Search, in order to add nodes according to
the Cascade architecture and to find the best topology for the network.

Propetty | Walue |
Mode D Autokleural |A
Imported Data
Exported Data
arighles
Architecture Cascade

Termination Cwieittin
Train Action

3 Run the AutoNeural node.
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Overview of This Group of Tasks

Now that you have created four predictive models and briefly examined assessment
statistics for each of them, you can compare the models in order to select the model that
best predicts your target.

You use the Model Comparison node to assess how well the Regression, Neural,
AutoNeural, and Decision Tree models performed. The comparison is based on the
expected profit that would result from implementing the model. In the last set of tasks,
you learn how to produce and score new data using the Score node. The scored data
identifies the candidates who are most likely to donate money.

Compare Models

In this task, you use the Model Comparison node to benchmark model performance
and find a champion model among the Regression, Neural Network, AutoNeural, and
Decision Tree nodes in your process flow diagram. The Model Comparison node enables
you to judge the generalization properties of each predictive model based on their
predictive power, lift, sensitivity, profit or loss, and so on.

1 Drag a Model Comparison node from the Assess tab of the node toolbar into the
Diagram Workspace. Connect the Model Comparison node to the Regression,
Decision Tree, AutoNeural, and Neural Network nodes as shown below.



110 Compare Models A Chapter 6

H%Q

tatExplore  MultiPlot

Data Partition Replacement

Impute

Forrellerolit

Transfarm
Yariahles

Regressi:\

Decision Tree

£3o

Interactive
Decision Tree

Meural Metwark

2 Right-click the Model Comparison node and select Run. A Confirmation window

appears. Click .
Note:

Running the process flow diagram might take several minutes. A

3 Click when the process flow diagram run is complete. The Results

window opens.

@ Results - Model Comparizon |_ [O]x]
File Edit “iew ‘Window
ROC Chart: TARGET_B !EI- ﬁ Fit 5t =10l
Data Role = TRAIM || Data Role = Selected MD...I Predecesso...l Model Maode
Avtoheural Avtoheural
1.0 1.0
e 2os PMewral PMewral
= =
£ 05 Eo0s Reg Reg
: 04 : 04 Tree Tree
] 1l o 02
D 0 D 0
Kl |
——_Baseline_ = AutoMeural
== NMeural =—REeg
—=Tree
Kl i
| Scor =10 =|| B =10l %
Select Chart 24 valid: 4]
- || =5 Average
26 lected Profit £
Data Role = TRAIN = eote rofit folml
27 [odel Model Hode TARGET B
:.j 2.5 28
"0 29 iutolNeural — 0.25478
21 . 30 Neural 0.26183
s IR Reg 0.26200
Cio 32 Tree 0.25459
0 20 40 60 80100 33 -
Narila ha o _qI_I ¥

The Results window displays the following information for a binary target:

Receiver Operating Characteristics (ROC) charts. The charts overlay the

competing models for both the training and validation data (this example does
not create a test data set). Each point on the ROC curve represents a cutoff
probability. Points closer to the upper-right corner correspond to low cutoff
probabilities. Points closer to the lower-left corner correspond to higher cutoff
probabilities. The performance quality of a model is indicated by the degree that
the ROC curve pushes upward and to the left. This degree can be quantified as
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the area under the ROC curve. The area under the ROC curve, or ROC Index,

is summarized in the Output window of the Model Comparison node.

0 A Score Rankings chart. For a binary target, all observations in the scored data

set are sorted by the posterior probabilities of the event level in descending
order for each model.

O A detailed listing of model diagnostics. The list is provided in the Output
window. In this example, the Regression model is marked Y as the selected
model, because the Regression model maximizes the average profit when

applied to the validation data. Maximizing average profit is the default criterion
for choosing the best model when a profit matrix is defined and when validation

data is available. The scoring formula for this model will automatically be
passed to the successor Score node for scoring new data.

Note: You can also use the Fit Statistics window to determine the champion
model. The champion model displays a ¥ in the Selected Model column of the

Fit Statistics window. A

4 Change the vertical axis statistic on the Score Rankings Plot to display the

predicted profit. Right-click the background of the Score Rankings plot and select

Data Options.

5 In the Data Options Dialog window, scroll down the list of variables until you see

the variable Profit. Change the Role of Profit to ¥.

& Data Options Dialog

Roles I Wherel Snr‘tingl

IA Wariakle Role IType IDescrip’[iDn |F0rmat I
IIMF‘_DONOR_AG... Mumeric Report: mean IMP ... =
P _DiOMOR_&AG. . Mumeric Report: min IMP_Dr...

LIFT Mumeric Lift

LIFTC Mumeric Curnulative Lift

hWODEL Group Character hodel Mode

] Murmeric Observation Mum...

MUMBEROFEWER. .. Murmeric Murnber of Events

PARENMT Character Predeces=zor Mode

PROFIT Mumeric Profit

RESP More Murmeric % Fesponse

FESPC Lattice-x Mumeric Cumulative % Re...

TARGET | attice-y Character Target Variahle

TOTALPROFIT e Mumetric Total Profit

LURBAMICITY _C Murmeric Fepott: UREBAMICI..

LREAMICITY _R Hl\mmeric Fepott: UREBAMICI..

LUREAMICITY _S roup Index MurmEric Fepott: UREBAMICI..

LREAMICITY _T Murmeric Fepott: UREBAMICI..

URBAMICITY __O... Murmeric Fepott: UREBAMICI.. ll

[ Ao muttiple role assignments

o |

6 Click .

7 Move your mouse pointer over the different points for each model (line) in the
Score Rankings plot to see the predicted profit values.
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@ Results - Model Comparison M=l E
File Edit “iew ‘wWindow

B Blsl el %]
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When you examine the Score Ranking Overlay charts, the Autoneural model
captures the most profit in the first decile of the training data, but the same is not
true for the validation data. This is also not true for the other deciles. Note that
the maximum profit for the models varies across the deciles, but overall the
Regression model maximizes total and average profit. The Results window

provides the same assessment charts and reports as the Results windows of the
individual modeling nodes.

8 Close the Results window.

Score New Data

Overview

The final step in most data mining problems is to create scoring code that you can
use to score new data. For example, now that you have a good predictive model for
profitable donations, you can apply that model to raw data that does not include the
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target variable TARGET_B. Thus you can automate the model scoring process of
deciding which individuals are likely to donate.

There are several types of scoring including interactive, batch, and on-demand.
Typically, interactive scoring is performed on smaller tables, while batch scoring is
performed on larger tables. On-demand scoring includes single transactions that can be
performed in a real-time setting. There are also different types of score code. By
default, the score code that SAS Enterprise Miner creates is SAS code. It is also
possible to create Java or C code for integration into environments other than SAS.
Additionally, SAS Enterprise Miner can create PMML code, which is an XML
representation of the model for scoring in other databases. In this topic, you will
perform interactive scoring that produces SAS code.

You use the Score node to manage, edit, export, and execute scoring code that is
generated from a trained model or models. The Score node generates and manages
scoring formulas in the form of a single SAS DATA step, which can be used in most SAS
environments even without the presence of SAS Enterprise Miner.

In this example you use the Score node to score a score data set within the process
flow.

Define Data Source for Scoring

In order to add a data set to an Enterprise Miner process flow diagram, you must
define it as a data source first.
In this task, you define the DONOR_SCORE_DATA as a data source.

1 Right-click the Data Sources folder in the Project Panel and select create Data
Source. The Data Source wizard opens.

2 In the Source box, select SAS Table. Click [Next].
3 In the Data Source Wizard — Select a SAS Table window, click [Browse].

4 In the Select a SAS Table window, double-click the DONOR library folder to
expand it. Select the DONOR_SCORE_DATA table and click [OK].

Select a 5AS Table E
DONOR

SAMPSIO
SASHELP
WORK

DONCR_RAW DATA,

Refresh | Properties... | Ok I Cancel

DONOR.DONOR_SCORE_DATA appears in the Table box of the Select a SAS
Table window. Click [Next].

5 Click in the Table Information window.

6 Select Basic in the Metadata Advisor Options window. Click [Next|. The Column
Metadata window opens.

7 Redefine the metadata by setting the Role for the CONTROL_NUMBER variable
to ID.

8 Click [Next]. The Data Source Attributes window opens.
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9 In the Role box, select Score from the list to indicate that this data set contains

Score data.
Data Source Wizard -- 5tep b of 6 Data Source Attributes =] E3
D
T e ‘ You may change the name and the role, and can specify
& { R ) a population segment identifier for the data source o be
rd’ f‘ : craated.
Mame IDONOR_SCORE_DATA
Role : m
Segment : |
Motes :
= Back | Finish | Cancel | Help |

10 Click [Finish]. The DONOR_SCORE_DATA data source appears in the Data
Sources folder in the Project panel.

Add Score Data and Score Node to Diagram

1 Drag the DONOR_SCORE_DATA data source from the DONOR library folder in
the Project panel into the Diagram Workspace. Place it near the Model
Comparison node.

2 Drag a Score node from the Assess tab of the node toolbar into the Diagram
Workspace. Connect both the Model Comparison node and the
DONOR_SCORE_DATA data source to the Score node.

n
n,-"
3 Model

Comparison

DoOMOR_
SCORE_DATA

3 Run the Score node in order to apply the SAS scoring code to the new data source.
4 View the Score node results when the node has finished running.
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@ Results - Score

File

Edit  Wiew ‘Window

[l E3

Ell &l =)

545 Code M =

1 g
2 * EM SCORE CODE;
3 * VERSION: 5.2:
4 * GENEEATED BY: CARVNT\Sasuser:
5 * CREATED: Z30CTZ005:16:21:53;
I B e e
':.‘ g
g * TOOL: Input Data Source;
o * TYPE: SAMPLE:
10 * NODE: Ids:
11 g
12 g
13 * TOOL: Partition Class; il
' of
—ioix]
28 Variable Value YValue Frequency Percent ;I
29
30 D_TARGET B . u} 491 22,8585 |
31 D TARGET B . 1 1657 77,1415
32
33
34 Data Role=TRAIN Output Type=CLASSIFICATION
35
36 Numeric Formatted
37 Variable Value Yalue Fregquency Percent
38
39 I _TARGET E . a 10g54 laa
* "
JET I '

As you examine the results, notice these details:

O

5 Select View » Scoring in order to view the SAS, C, and Java score code.
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The SAS Code window displays code that was generated by the entire process
flow diagram. The SAS score code can be used outside the Enterprise Miner

environment for custom applications. The results also contain C and Java
translations of the score code that can be used for external deployment.

The Output window displays summary statistics for class and interval
variables. You can also view lists of the score input and output variables.

ol Results - Score

File

E" | Froperties

Edit

Wiew  window

a
ing Input W ariables
SA5 Resulkz ¢ Output % ariables
[araphs b 545 Code

[Frapt tizand Java Score Code
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6 Select View » Graphs » Bar Chart in order to display a bar chart of the values

of the target variable for classification, decision, and segment output types, if
applicable, for each data set.

Data Role = SCORE Data Fole = SCORE =
Clutput Type = CLASSIFICA.. | | Output Type = MODELDECI...
100 44— BOH
= a0 - = G0 —
8 507 S 404
g - g L
20 - 207
0 | o | |
i o1
Formatted Value Formatted Value
Data Raole = TRAIM Data Role = TRAIM -

Clutput Type = CLASSIFICA.. | | Output Type = MODELDECI. ..
100 ——

B0 —
o B0 = 60 -
@ 50 7 [ah]
= 2 ap 4
a 407 a
20 2077
0 [ 0 [

i =l

7 Select View » Graphs » Histogram in order to display a histogram of the
values of the predicted, probability, and profit output types for each of the data sets.
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Histogram [_ O]

“ariable = P_TAR. | Variahle = P_TAR. | YWariahle = P_TAR. &
Data Role = TRAIM || Data Role = WALl | |Data Role = SCOR

Yariable = P_TAR...| %ariable = P_TAR.. | |variahle = P_TAR.
Data Role = TRAIM || Data Role = YALL.. || Data Role = SCOR—

“ariable = EFP_TA.. | |%ariable = EP_TA . ||variahle = EFP_TA.

_r‘||:.+:. Bala = TRAIM || Mata Pala = WAL Mata Prala = Qrﬁl:' bl
4 3

8 Close the Results window.

9 Click the ellipsis button to the right of the Exported Data property in the Score
node Properties panel in order to view the scored data.

Propetty Walue

Mode ID Score -
Imported Data
Expaorted Data

ariables
Type of Scored Data 1=
IIse Fixed Output Mames [Yes
Hide Wariables i [a]

10 Select the SCORE port table in the Exported Data - Score window.
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Exported Data - Score Ed

Part | Table | Roe | Data Exists |
TRAIN EbfiS Score_TRAIM  [Train es
v ALIDATE EMWS Score_vALID... [vaidate  |Ves

TEST EnNS Socore_TEST  [Test Mo
El IR

Browwse. . Explore...K’JS Properties. . | 8124 I

11 Click [Explore].

12 Examine the SCORE table. Values for predicted profit, expected profit, and other
variables were generated by the Score node for export.

. Explore - EMWS Score_SCORE |- [O] %]
File ‘“iew Actions: ‘Window
SE[O| %]
=10lx
Property alue
Sample Method Top
Fetch Size Default
Random Seed 12345
Fetched Rows 2000
Apply | Plat... |
& EMw/S_Score_SCORE M [=] 3
GE...| Unnormalize...| Decisian: ... Expected Profit: TARGET_E | Predicted: TARGET_E=1 | Predicte
an 0 0023225 ER
a1 0.216599 0.047793 0g—
01 0.09445 0.039631 09
[y} 0.561481 0070765 0s
01 0.323403 % 0.054534 03
o1 0317726 0.054515 09
a1 0.426211 0.061747 0%
01 01218 0.041455 09
[y} 1.004705 0100314 0a

13 Close the Score table. Click to close the Exported Data window.

Add a SAS Code Node

1 Drag a SAS Code node from the utility tab of the nodes toolbar into the
Diagram Workspace, and connect it to the Score node.

2 Right-click the SAS Code node and select Rename.

3 Type Best Potential Donors on the Node name box.



Working with Nodes That Assess /A Add a SAS Code Node 119

H‘"EP

Model
Comparison

Score Best Potential
Donaors

DOMOR_
SCORE_DATA

4 In the SAS Code node Properties panel, click the ellipsis button to the right of the
Variables property to open the Variables table. The name of the average profit
variable is EM_PROFIT and the name of the decision variable is EM_DECISION.

5 Scroll to the right to see the Label column. You can widen the column to view its
entire contents.

Mame Lakel |
DONOR_GENDER -
O_TARGET_B Decision: TARGET_RB
Eli_CLASSIFICATION Frediction for TARGET_B J
EW_CLASSTARGET Target wariable: TARGET_B
EWM_DECISION Recommended Decision for TARGET B
El_EYEMTPROBABILITY Frohability for level 1 af TARGET_B
EM_PROBABILITY Frobahility of Classification
EM_FROFIT Expected Profit for TARGET_BE
El_SEGMEMNT Sedgment
EP_TARGET B Expected Profit: TARGET B
FILE_CARD_GIFT
FREGLEMCY _STATUS_S97hK Ll

A [ 71
Explare... | O I Cancel | Help |

6 Close the Variables window.

7 In the SAS Code node Properties panel, click the ellipsis button to the right of the
SAS Code property to open the SAS Code window.

Propetty Yalue
Mode [0 EMCODE -
Imported Data
Exported Data
ariables

{0 [+

15AS Code
Code Location Internal File
-|External File

|Catalon Entry
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The SAS Code window has two tabs: Macro Variables and Macros. These tabs
contain the system-defined macro variables and their value if these are already
assigned, and a list of macros provided by SAS.

SAS Code
J Macra Yariable I Current “alug I : Ceneral =
“EM_FROPERTY_Componant SASCode =

=

EM_IMFORT_DATA EEM_LIB. Scara_TRAIM Systemn
|EM_IMFORT_DATA_EMINFO EEM_LIB. Reg_EMINFO macto
EM_IMPORT_DATA_CMETA &EM_LIB..Score_Chieta_ TRAIM _ILI
-EM IMPORT WAl INATE LEM IR Srara WAl INATE ﬂ ﬂ_l b

Macro Variables |;§' | Macros B |

|

[

S5 Code iy I
Ok I Cancel |

8 Select the Macro Variables tab. The tab holds a list of macros that you can
reference in your SAS code. Examine the Imports section of the Macro variable
list. A macro variable named EM_IMPORT_SCORE appears in this section. You
can use the EM_IMPORT_SCORE macro variable to reference the score code that
you import into the SAS Code node.

SAS Code
Macra Yariakle I Currert YWalue | :EM IMPORT SCC

_E| -

EM_IMFORT_DATA LEM_LIB..Score_TRAIM

|EM_IMPORT_DATA_EMIMFIZEM_LIB. Reg EMINFO Ivlacro wariable

“EM_IMPORT_DATA CMETAGEM_LIB. Score_CMeta TRAIM idmtifying the

JEM_IMPORT WALIDATE EEM_LIB. Scare_WALIDATE acore data get.

EM_IMPORT_VALIDATE_CREEM_LIB. Score_Cheta TRAIN
EM_IMFORT_TEST
EM_IMFORT_TEST_CMETA

"EM_IMFORT_SCORE &EM_LIB.. Score_SCORE LI ‘I | _'I
Macro Variables |;§' | Macros B‘ |
S5 Code iy I

Ok I Cancel |

9 On the sAS Code tab, enter the following code:
proc means data=&em import_ score n min mean median max;
class em decision;
var em profit;

run;
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proc print data=&em_import score noobs;

var control number em profit;

where em profit gt .60;

run;
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Note: The PROC MEANS step calculates descriptive statistics for expected profit,

and the PROC PRINT step generates a list of donors that exceed an expected

profit threshold. A

10 Click to close the SAS Code window.
11 Run the SAS Code node named Best Potential Donors and view the results.

@t Results - Best Potential Donors M=] E3

File Edit “iew “Window

5 e[ [ A

43
44
45 CONTROL_
46  NUMEER
47

45 00000142
49 00000365
50 00000387
51 00000564
52 00000702
53 00000743
54 00001012
55 00001245
56 00001400
57 00001493
58 00001789
59 00001520
60 00002085
6l 00002315
6z 00002431
63 00002678
64 00002691
65 00002861
66 00003018
AT NNNN3?76

EM_FROFIT

STk O OFF R RFRERD®BRRSRSO R

06332
L 34501
54473
. 00578
L B4Z96
69450
L 33935
L 94034
07745
L 20710
L5724
.BZ696
16570
LA5415
L 14518
L 99633
L 35865
17805
L 34394

ardsn

12 Select View » SAS Results » Log in order to view the SAS log.
13 Close the Results window.
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Overview of This Group of Tasks

You have fit and built a predictive model using training and validation data. You
have used the model to score new data. What are some potential next steps for the
scored data?

You can place your scored data in a cube for Online Analytical Processing (OLAP)
exploration, or use it as input for reports or further analysis. You might want to save
the model in an archive so you can share it with other users. There are a number of
ways you can save your data mining model for future use.

One of the ways that you might save your model is with model packages. With
Enterprise Miner, you can create model packages and share them with fellow data
miners, business managers, and data managers throughout the organization. Besides
enabling you to share models, model packages also provide an audit trail of the
underlying data mining processes. With packages, process flow diagrams can be
archived, stored, and re-used. The Enterprise Miner model package also includes an
XML file that completely defines the process flow diagram layout and configuration for
each component node.

Create Model Packages

To create a model package:

1 Right-click the SAS Code node named Best Potential Donors, in the Diagram
Workspace, and select Create Model Package.
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- ] - [m]
Score Best Potential

Donars
]

o Edit ariables...

O Update

# FRun

=P Results...

% Create Model Package...

@ Export Path az 545 Progra

Cut
Copy

Delete
Fename
Select Al
Select Modes

Caonnect Modes

The model package that you create contains the output and results for each
node that precedes the node you select. Use the terminal node in a process flow
diagram to capture the entire diagram in a model package.

2 Type a model package name in the Input window.

Input |

Wodel Package Mame:
IGetting Started Chartable Dl:nnatin:nn3|

] Cancel |

3 Click to create the package. In the Diagram Workspace, the SAS Code node
is highlighted in blue while the model package is being created.

[m] O [m]
=
a a
BestFotential
Donars
[m] [m] [m]

4 Click in the Run Status window.
The report is stored inside the Model Packages Folder of the Project panel.
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etting Started Charitable Giving Example
2] Data Sources
| Diagrams
Daonations
=\ Model Packages

zetting Started Charitable Donations

To store a model package:

a Find your EM Projects folder on your local machine or on your allotted server
space. Each Enterprise Miner project that you create is stored in a folder
under the EM Projects folder.

b Open your Getting Started Charitable Donations project folder and locate a
Reports folder. The Reports folder is the default location for the model
packages that you create.

@ C:\Documents and Settings\loreye\My Documents\My SAS Files\9.1\EM_Projects\Getting._. [H[=]

File Edit “iew Favortes Tools  Help | l?

O Back - d - ﬂ‘ |/'- ) Search [~ Folders |E|v

Address Iﬁ C:ADocuments and Settingshsasusery Documentsibdy 545 Files\9.1\EM_Proiects\Gettingﬂ a Go

Foldsrs x gminingresult.sas?bcat
) My SAS Files | &) miningResult spk
B IS 91 riningF esult. ural
) claszdoc

=3 EM Projects
= I EM_Projects
) Donor_Data
=l I[Z) Getting Started Charitable Giving Example
=0 DataSources
= 2y Reports
ek Cictting Started Charitable Donations_1THLL:
=0 Svstem b
=) Workszpaces
0 Test Donar
I emdata
I empraj
) reports LI

¢ Examine the model package folders. They contain the following files:

O miningresult.sas7bcat — the SAS catalog that contains a single SLIST
file and metadata from the process flow diagram.

0 miningResult.spk — the model package SPK file.

0 miningResult.xml — an XML file that contains metadata about the
process flow diagram. This file contains the same information as
miningresult.sas7bcat.

d Right-click a model package in the Project panel of the workspace to open it,
register it to the Web-based model repository, re-create the diagram and save
it as another package, or to delete it.
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About SAS Package (SPK) Files

A SAS Package (SPK) file is a container file to which modeling results are exported.
SPK files are compressed and can contain any of the following file types:

O

O O o oo oo d

SAS files

SAS catalogs

SAS data sets

SAS databases (such as DMDB, FDB, and MDDB)

SAS SQL views

Binary files (such as Excel, GIF, JPG, PDF, PowerPoint, and Word)
HTML files (including ODS output)

References strings (such as a URL)

Text files (such as a SAS program)

You use the SAS Package Reader to view the SPK files. For more information about
the SAS Package Reader, see http://support.sas.com/rnd/itech/doc/reader/
index.html.

Use the SAS Package Reader to View Model Results

You can download the SAS Package Reader, from the SAS Web site. To download the
software:

1

2
3
4

Direct your Web browser to http://support.sas.com.
Select software Downloads.

Select SAS Integration Technologies.

In the For SAS®9 category, select SAS Package Reader.

The SAS Package Reader displays a list of the entries within a package. It
contains a built-in viewer for SAS data set entries and it launches a Web browser
for all other entry types. You can use the SAS Package Reader and SPK files to
share projects and reports with those who do not have SAS installed on their
machines.
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1 5AS5 Package Reader
File  Help

Use the SAS Package Reader to View Model Results

| 7|@| e']s0]|:|

@ sPK Package Description |
=HE saSCode Assessment decile statistics

1 Model Comparison Aszzessment score distribution statistics

{1 Regression

—|:| ‘Workspace configura Fit iztics

FHCD Score ] Flowy score code

—1 Transtorm Varisbles B Log

1 DONOR_RaW_DATA Misclassification Table

1 impute Fx Output

[+]—|:| Path score code Fa QUTSER

{21 Autoheural s Properties

{1 Heural Metwark Fx Publizh score code

{1 Mining Result Metadat: e Report Metadata

—|:| DOMNOR_SCORE_DAT E Fun Status

{2 Best Potential Donors Tabular fit statistics

{1 ariable Selection Training Code

{1 Replacemert Training variables

—aall Tree_Plat

TreePlot XML

5 To open a package directly from Enterprise Miner, expand the Model Packages

folder and double-click the model package that you want.

Getting Started Charitable Giving Example
53| Data Sources

| Diagrams

| Model Packages

Getting Started Charitable Donations

1] U=ers
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The package opens and displays the process flow diagram.

! Package - Getting Started Charitable Donations [_ [O] x|
File Edit Actions “iew ‘Window
BBl s| =) 4|
Diagram [

Data Padition Replacement

Kl

Decision Tree

Impute Transfarm Wariables Regression

e
YVariable Sniliﬁy

Meural Metwork

6 Double-click the Regression node to open the Results window.

@l Package - Getting Started Charitable Donations -> Regression

File Edit “iew ‘Window
=] ) = s
-lglx
Select Chart: (ST AT | TARGET _| Fit statistics |Statistics La.| T
ARGET B _AIC_ kaike's Infor «
2325 ARGET_B _ASE_ Average Sou...
[ ARGET_B _ANMERR_ Average Erro...
: 2.00 SRGET_ B _DFE_ Degrees af F...
2175 ARGET_B _DFM_ Model Degre. ..
E - ARGET_B _DFT_ Total Degree...
g 10 ARGET_E  |_DIV_ Diivigor for ASE
5 1.25 ARGET_BE _ERFR_ Error Function
L@ ARGET_E  _FPE_ Final Predicti. .
T T T T T T ARGET_BE AN _ Maximuim k...
0 20 40 60 80 100 ARGET_ B _MSE_ Mean Square...
Decile ARGET_B  _NOBS_ Sutn of Fregu...
|_ TRAIN —\ALIDATE | ARGET_E koA Mumber of Ez... -
4| | 3|
| Effects P I =1 =10 x|
: 2
E z
2
E 0.4 3
= 4
;3 5 Wariable Summary
02 5
= 7 ROLE LEVEL COTHT
2z 38
< 9 INFUT BINARY 4
0.0 10 INPUT INTERVAL 30
T2 3 4 5 6 7 8 9 10 4y rypor NOMINAL 13
Effect Number 12 EREJECTED  INTERVAL 1
i ol

7 Close the Results window.
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View the Score Code

If you ran a node that generated SAS, C, Java, or PMML score code, you can view

the code from the node’s Results window.

1 From the Results window main menu, select View » Scoring » SAS Code .

il Package - Getting Started Charitable Donations -»

File Edit | Wiew “window

@" || Properties ]
oo SAS Resuls b =
: Ol x|
m g .:;.:.ring [ SAS Code
Select Chal  Assessment » PRIRIL Code
fodel b
[
e Tebe
: 200 Graphwizard
.E 1.75
=]
= 150
g 1.25
u eu)
1.00
T T T T T
0 20 40 G0 a0 100
Decile
|=—TRAIN  ——VALIDATE |

Note: Enterprise Miner includes a set of SAS macros that you can use to run
process flow diagrams during off-peak computing hours, in batch mode. Batch
processing code that recreates the process flow diagram and its settings is

generated when you create a model package. You can use the Enterprise Miner
graphical user interface to view and interact with results that were generated by
process flow diagrams that were executed in batch mode. A

2 Select View » Batch Code from the window’s main menu in order to view the

batch code that has been saved in a process flow diagram’s model package,
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it Package - Getting Started Charitable Donations M= E3
File Edit Actions | Wiew “Window

B2 e E

d

Workspace

Scaring
Surnmary
Table

[srapt Sizand

N

TA Decision Tree e—-—r-oi
WYariable Selection to

i e~

artition Replacement Neural Netwark

Kl 2

3 Close the Results window.

Register Models

You can archive and register saved models in the Enterprise Miner Model Repository.
The repository resides on the SAS Metadata Server. When you register a model, the
model details and metadata are stored on the Server. The Server allows data mining
models to be shared. The SAS Metadata Sever can be used to distribute models to those
who are not Enterprise Miner users.

The first step is to create a model package, as you have just done above. Since you
created the model package from the SAS Score node, the champion regression model
will actually be registered for retrieval via other SAS interfaces like the Model
Manager. To register other models, such as the Decision Tree and Neural Network
models, you first need to create a model package for each of them.

1 In the Project panel, open the Model Packages folder and right-click the package
that you created. Select Register.

Getting Started Charitable Giving Example

Bl Data Sources

k] Diagrams

== Madel Packages

I—‘% (Getting Started Charitable Donationg

Al Uzers Open
Delete

Recreate gglam

Save Az
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The Register a Model Package window opens.

Dezcription I Dietailz I

Model Repositary:  d15005 na sas com: Foundsation
Wodel Groups: j

Idarme: Getting Started Charitable Donations
Mining Function:

Mining Algorithrn:  Regression

Ok I Cancel Help

On the Model tab, you can select a model group if groups have been defined.
None have been defined in this case.

2 On the pescription tab, you can type descriptive text such as Getting Started
Charitable Giving Example Model. You can also assign a model subject, and
assign a model rating.

Reaqgister a Model Package. E3

Model Descrigtion | Details |

Descriphion’ Getting Started Charitable Giving Example Hndell

Subject  [Retertion =]

Reting: | =l

Ok I Cancel | Help |

3 Select the Details tab to see metadata about the registered model.
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Reaqgister a Model Package. E3

Mol | Description  Details |

I Property I “alue I

{ID Getting Started Charitable Donations_3J028 -

||Name Getting Started Charitahle Donations

||Fi|e MName ClDocuments and Settingsioreyelbly Documentsi

||ru1ining Function

Mining Algatithim Regression

Target TARGET_B
ersion 5.2

Diagram 1D EfwWE

||Nnde Description Best Potential Donors

!!HEpDSItDrIES ;'

Ok I Cancel | Help |

4 Click to register the model.

Save and Import Diagrams in XML

Enterprise Miner process flow diagrams can be encapsulated as XML files and
shared with other users. In the Project Navigator, open the Diagrams folder and
right-click any diagram in order to create an XML wrapper for a process flow diagram,
or to import a process flow diagram that was saved in XML format.

1 Right-click the process flow diagram’s folder from the Diagrams subfolder of the
Project panel. Select save As.

etting Started Charitakle Giving Example

I.J—]—@] Data Sources

':E DONOR_RAVY DATA,
DOMOR_SCORE_DATA

=[] Diagrarms

Donations

[—]—@I Model Packag

Getting St g«ag Create Diagram
El—[_E\.l zers Import Diagram fronn kL.

el

Rename

Delete

Claze

Prirt.... ! |

2 Specify the folder where you want to save your process flow diagram, and type the
name in the File name box. Click to store your diagram as an XML file.
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Save in; Iil Dizgrams ;I T 7 EE

®©
Desktop File name: IGeﬁing Started Charitable Donati0n3| Save |

Files of type: I}(Mques(*_me) LI Cancel |
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3 To import a diagram, from the main menu, select File » Import Diagram from
XML, or, from the Project panel, right-click the biagrams folder and select Import

Diagram from XML.

Getting Started Charitable Giving Example
f—]—@l Data Sources

¥ DONOR_Rawy DaTa,

E DONOR_SCORE_DATA
Diagrams
,.'P Dona

et

gqg Create Diagram

4 Navigate to the location of the saved XML file and then click to import the

diagram.

Note: After you open an imported process flow diagram in the diagram
workspace, you will need to run the flow to generate results. If you import the
diagram into a project where the data sources do not reside, you will also need to

define these data sources. A
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Recommended Reading

Here is the recommended reading list for this title:

0 Data Mining Using SAS Enterprise Miner: A Case Study Approach
0 Getting Started with SAS Enterprise Miner 4.3

For a complete list of SAS publications, see the current SAS Publishing Catalog. To
order the most current publications or to receive a free copy of the catalog, contact a
SAS representative at

SAS Publishing Sales

SAS Campus Drive

Cary, NC 27513

Telephone: (800) 727-3228*

Fax: (919) 677-8166

E-mail: sasbook@sas.com

Web address: support.sas.com/pubs

* For other SAS Institute business, call (919) 677-8000.

Customers outside the United States should contact their local SAS office.
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Example Data Description

The following table describes the variables that are used in this example.

Table A2.1 Variables That Are Used in the Donor Data set

Variable

Description

CARD_PROM_12

CLUSTER_CODE
CONTROL_NUMBER

DONOR_AGE
DONOR_GENDER
FILE_AVG_GIFT
FILE_CARD_GIFT
FREQUENCY_STATUS-97TNK
HOME_OWNER

INCOME_GROUP
IN_HOUSE

LAST_GIFT_AMT
LIFETIME_AVG_GIFT_AMT
LIFETIME_CARD_PROM
LIFETIME_GIFT_AMOUNT
LIFETIME_GIFT_COUNT
LIFETIME_GIFT_RANGE
LIFETIME_MAX GIFT_AMT
LIFETIME_MIN_GIFT_AMT
LIFETIME_PROM
MEDIAN_HOME_VALUE
MEDIAN_HOUSEHOLD_INCOME

Number of card promotions received in the last 12
months

54 socio-economic cluster codes

The control number uniquely identifies each member of
the analysis population

Age as of June 1997

Actual or inferred gender
Average gift from raw data
Average card gift from raw data
Frequency status as of June 1997

H=Homeowner

U=Unknown
7 income group levels

A final field identifies donors who are part of the
organization’s In House program

Amount of most recent donation

Overall average gift amount

Total number of card promotions received
Total gift amount given

Total number donations given

Maximum less minimum gift amount
Maximum gift amount

Minimum gift amount

Total number of promotions received
Median home value in $100’s

Median household income in $100’s
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MONTHS_SINCE_FIRST_GIFT
MONTHS_SINCE_LAST_GIFT
MONTHS_SINCE_LAST_PROM_RESP

MONTHS_SINCE_ORIGIN
MOR_HIT_RATE

NUMBER_PROM_12
OVERLAY_SOURCE

PCT_ATTRIBUTE1
PCT_ATTRIBUTE2
PCT_ATTRIBUTES
PCT_ATTRIBUTE4
PCT_OWNER_OCCUPIED
PEP_STAR

PER_CAPITA_INCOME
PUBLISHED_PHONE
RECENCY_STATUS_96NK
RECENT_AVG_CARD_GIFT_AMT
RECENT_AVG_GIFT_AMT
RECENT_CARD_RESPONSE_COUNT
RECENT_CARD_RESPONSE_PROP
RECENT_RESPONSE_COUNT
RECENT_RESPONSE_PROP
RECENT_STAR_STATUS

SES

TARGET_B

TARGET_D

URBANICITY

WEALTH_RATING

First donation date from June 1997
Last donation date from June 1997

Number of months since donor has responded to a
promotion date from June 1997

This number is derived from MONTHS_SINCE_FIRST

Total number of known times the donor has responded
to a mail order offer other than the national charitable
organization’s.

Number of promotions received in the last 12 months

M=Metromail
P=Polk
B=Both

Percent with attributel in the block

Percent with attribute2 in the block

Percent with attribute3 in the block

Percent with attribute4 in the block

Percent of owner-occupied housing

STAR-status ever (1=yes, 0=no)

Per capita income in dollars

Indicator of presence of published telephone listing
Recency status as of June 1996

Average gift amount to card promotions since June 1994
Average gift amount since June 1994

Response count since June 1994

Response proportion since June 1994

Response count since June 1994

Response proportion since June 1994

STAR (1,0) status since June 1994

5 socio-economic cluster codes

Response to 97NK solicitation (1=yes, 0=no)

Response amount to 97NK solicitation (missing if no
response)

U=Urban
C=City
S=Suburban
T=Town
R=Rural

?=Unknown

10 wealth rating groups
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assessment
the process of determining how well a model computes good outputs from input data
that is not used during training. Assessment statistics are automatically computed
when you train a model with a modeling node. By default, assessment statistics are
calculated from the validation data set.

association discovery
the process of identifying items that occur together in a particular event or record.
This technique is also known as market basket analysis. Association discovery rules
are based on frequency counts of the number of times items occur alone and in
combination in the database.

binary variable
a variable that contains two discrete values (for example, PURCHASE: Yes and No).

branch
a subtree that is rooted in one of the initial divisions of a segment of a tree. For
example, if a rule splits a segment into seven subsets, then seven branches grow
from the segment.

CART (classification and regression trees)
a decision tree technique that is used for classifying or segmenting a data set. The
technique provides a set of rules that can be applied to new data sets in order to
predict which records will have a particular outcome. It also segments a data set by
creating 2-way splits. The CART technique requires less data preparation than
CHAID.

case
a collection of information about one of many entities that are represented in a data
set. A case is an observation in the data set.

CHAID (chi-squared automatic interaction detection)
a technique for building decision trees. The CHAID technique specifies a significance
level of a chi-square test to stop tree growth.

champion model
the best predictive model that is chosen from a pool of candidate models in a data
mining environment. Candidate models are developed using various data mining
heuristics and algorithm configurations. Competing models are compared and
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assessed using criteria such as training, validation, and test data fit and model score
comparisons.

clustering
the process of dividing a data set into mutually exclusive groups such that the
observations for each group are as close as possible to one another, and different
groups are as far as possible from one another.

cost variable
a variable that is used to track cost in a data mining analysis.

data mining database (DMDB)
a SAS data set that is designed to optimize the performance of the modeling nodes.
DMDBs enhance performance by reducing the number of passes that the analytical
engine needs to make through the data. Each DMDB contains a meta catalog, which
includes summary statistics for numeric variables and factor-level information for
categorical variables.

data source
a data object that represents a SAS data set in the Java-based Enterprise Miner
GUI. A data source contains all the metadata for a SAS data set that Enterprise
Miner needs in order to use the data set in a data mining process flow diagram. The
SAS data set metadata that is required to create an Enterprise Miner data source
includes the name and location of the data set, the SAS code that is used to define its
library path, and the variable roles, measurement levels, and associated attributes
that are used in the data mining process.

data subdirectory
a subdirectory within the Enterprise Miner project location. The data subdirectory
contains files that are created when you run process flow diagrams in an Enterprise
Miner project.

decile
any of the nine points that divide the values of a variable into ten groups of equal
frequency, or any of those groups.

dependent variable
a variable whose value is determined by the value of another variable or by the
values of a set of variables.

depth
the number of successive hierarchical partitions of the data in a tree. The initial,
undivided segment has a depth of 0.

diagram
See process flow diagram.

format
a pattern or set of instructions that SAS uses to determine how the values of a
variable (or column) should be written or displayed. SAS provides a set of standard
formats and also enables you to define your own formats.

generalization
the computation of accurate outputs, using input data that was not used during
training.

hidden layer
in a neural network, a layer between input and output to which one or more
activation functions are applied. Hidden layers are typically used to introduce
nonlinearity.

hidden neuron
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in a feed-forward, multilayer neural network, a neuron that is in one or more of the
hidden layers that exist between the input and output neuron layers. The size of a
neural network depends largely on the number of layers and on the number of
hidden units per layer. See also hidden layer.

hold-out data
a portion of the historical data that is set aside during model development. Hold-out
data can be used as test data to benchmark the fit and accuracy of the emerging
predictive model. See also model.

imputation
the computation of replacement values for missing input values.

input variable
a variable that is used in a data mining process to predict the value of one or more
target variables.

interval variable
a continuous variable that contains values across a range. For example, a continuous
variable called Temperature could have values such as 0, 32, 34, 36, 43.5, 44, 56, 80,
99, 99.9, and 100.

leaf
in a tree diagram, any segment that is not further segmented. The final leaves in a
tree are called terminal nodes.

level
a successive hierarchical partition of data in a tree. The first level represents the
entire unpartitioned data set. The second level represents the first partition of the
data into segments, and so on.

libref (library reference)
a name that is temporarily associated with a SAS library. The complete name of a
SAS file consists of two words, separated by a period. The libref, which is the first
word, indicates the library. The second word is the name of the specific SAS file. For
example, in VLIB.NEWBDAY, the libref VLIB tells SAS which library contains the
file NEWBDAY. You assign a libref with a LIBNAME statement or with an operating
system command.

lift
in association analyses and sequence analyses, a calculation that is equal to the
confidence factor divided by the expected confidence. See also confidence, expected
confidence.

logistic regression
a form of regression analysis in which the target variable (response variable)
represents a binary-level or ordinal-level response.

macro variable
a variable that is part of the SAS macro programming language. The value of a
macro variable is a string that remains constant until you change it. Macro variables
are sometimes referred to as symbolic variables.

measurement
the process of assigning numbers to an object in order to quantify, rank, or scale an
attribute of the object.

measurement level
a classification that describes the type of data that a variable contains. The most
common measurement levels for variables are nominal, ordinal, interval, log-interval,
ratio, and absolute. See also interval variable, nominal variable, ordinal variable.
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metadata
a description or definition of data or information.

metadata sample
a sample of the input data source that is downloaded to the client and that is used
throughout SAS Enterprise Miner to determine meta information about the data,
such as number of variables, variable roles, variable status, variable level, variable
type, and variable label.

model
a formula or algorithm that computes outputs from inputs. A data mining model
includes information about the conditional distribution of the target variables, given
the input variables.

multilayer perceptron (MLP)
a neural network that has one or more hidden layers, each of which has a linear
combination function and executes a nonlinear activation function on the input to
that layer. See also hidden layer.

neural networks
a class of flexible nonlinear regression models, discriminant models, data reduction
models, and nonlinear dynamic systems that often consist of a large number of
neurons. These neurons are usually interconnected in complex ways and are often
organized into layers. See also neuron.

node
(1) in the SAS Enterprise Miner user interface, a graphical object that represents a
data mining task in a process flow diagram. The statistical tools that perform the
data mining tasks are called nodes when they are placed on a data mining process
flow diagram. Each node performs a mathematical or graphical operation as a
component of an analytical and predictive data model. (2) in a neural network, a
linear or nonlinear computing element that accepts one or more inputs, computes a
function of the inputs, and optionally directs the result to one or more other neurons.
Nodes are also known as neurons or units. (3) a leaf in a tree diagram. The terms
leaf, node, and segment are closely related and sometimes refer to the same part of a
tree. See also process flow diagram, internal node.

nominal variable
a variable that contains discrete values that do not have a logical order. For example,
a nominal variable called Vehicle could have values such as car, truck, bus, and train.

numeric variable
a variable that contains only numeric values and related symbols, such as decimal
points, plus signs, and minus signs.

observation
a row in a SAS data set. All of the data values in an observation are associated with
a single entity such as a customer or a state. Each observation contains either one
data value or a missing-value indicator for each variable.

partition
to divide available data into training, validation, and test data sets.

perceptron
a linear or nonlinear neural network with or without one or more hidden layers.

predicted value
in a regression model, the value of a dependent variable that is calculated by
evaluating the estimated regression equation for a specified set of values of the
explanatory variables.
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process flow diagram
a graphical representation of the various data mining tasks that are performed by
individual Enterprise Miner nodes during a data mining analysis. A process flow
diagram consists of two or more individual nodes that are connected in the order in
which the data miner wants the corresponding statistical operations to be performed.

profit matrix
a table of expected revenues and expected costs for each decision alternative for each
level of a target variable.

project
a collection of Enterprise Miner process flow diagrams. See also process flow diagram.

root node
the initial segment of a tree. The root node represents the entire data set that is
submitted to the tree, before any splits are made.

rule
See association analysis rule, sequence analysis rule, tree splitting rule.

sampling
the process of subsetting a population into n cases. The reason for sampling is to
decrease the time required for fitting a model.

SAS data set
a file whose contents are in one of the native SAS file formats. There are two types of
SAS data sets: SAS data files and SAS data views. SAS data files contain data
values in addition to descriptor information that is associated with the data. SAS
data views contain only the descriptor information plus other information that is
required for retrieving data values from other SAS data sets or from files whose
contents are in other software vendors’ file formats.

scoring
the process of applying a model to new data in order to compute outputs. Scoring is
the last process that is performed in data mining.

seed
an initial value from which a random number function or CALL routine calculates a
random value.

segmentation
the process of dividing a population into sub-populations of similar individuals.
Segmentation can be done in a supervisory mode (using a target variable and various
techniques, including decision trees) or without supervision (using clustering or a
Kohonen network). See also Kohonen network.

self-organizing map
See SOM (self-organizing map).

SEMMA
the data mining process that is used by Enterprise Miner. SEMMA stands for
Sample, Explore, Modify, Model, and Assess.

sequence variable
a variable whose value is a time stamp that is used to determine the sequence in
which two or more events occurred.

SOM (self-organizing map)
a competitive learning neural network that is used for clustering, visualization, and
abstraction. A SOM classifies the parameter space into multiple clusters, while at
the same time organizing the clusters into a map that is based on the relative
distances between clusters. See also Kohonen network.
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target variable
a variable whose values are known in one or more data sets that are available (in
training data, for example) but whose values are unknown in one or more future data
sets (in a score data set, for example). Data mining models use data from known
variables to predict the values of target variables.

test data
currently available data that contains input values and target values that are not
used during training, but which instead are used for generalization and to compare
models.

training
the process of computing good values for the weights in a model.

training data
currently available data that contains input values and target values that are used
for model training.

transformation
the process of applying a function to a variable in order to adjust the variable’s
range, variability, or both.

tree
the complete set of rules that are used to split data into a hierarchy of successive
segments. A tree consists of branches and leaves, in which each set of leaves
represents an optimal segmentation of the branches above them according to a
statistical measure.

validation data
data that is used to validate the suitability of a data model that was developed using
training data. Both training data sets and validation data sets contain target
variable values. Target variable values in the training data are used to train the
model. Target variable values in the validation data set are used to compare the
training model’s predictions to the known target values, assessing the model’s fit
before using the model to score new data.

variable
a column in a SAS data set or in a SAS data view. The data values for each variable
describe a single characteristic for all observations. Each SAS variable can have the
following attributes: name, data type (character or numeric), length, format,
informat, and label.

variable attribute
any of the following characteristics that are associated with a particular variable:
name, label, format, informat, data type, and length.

variable level
the set of data dimensions for binary, interval, or class variables. Binary variables
have two levels. A binary variable CREDIT could have levels of 1 and 0, Yes and No,
or Accept and Reject. Interval variables have levels that correspond to the number of
interval variable partitions. For example, an interval variable PURCHASE_AGE
might have levels of 0-18, 19-39, 40-65, and >65. Class variables have levels that
correspond to the class members. For example, a class variable HOMEHEAT might
have four variable levels: Coal/Wood, FuelOil, Gas, and Electric. Data mining
decision and profit matrixes are composed of variable levels.
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